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About This Book

/A WARNING! Text set off in this manner indicates that failure to follow directions could result in bodily

harm or loss of life.

/A CAUTION: Text set off in this manner indicates that failure to follow directions could result in
damage to equipment or loss of information.

B NOTE: Text set off in this manner provides important supplemental information.
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1 Installing and Customizing the
Software

If your computer was not shipped with a Microsoft operating system, some portions of this
documentation do not apply. Additional information is available in online help after you install the
operating system.

B NOTE: If the computer was shipped with Windows Vista or Windows 7 loaded, you will be prompted
to register the computer with HP Total Care before installing the operating system. You will see a
brief movie followed by an online registration form. Fill out the form, click the Begin button, and follow
the instructions on the screen.

/A CAUTION: Do not add optional hardware or third-party devices to the computer until the operating
system is successfully installed. Doing so may cause errors and prevent the operating system from
installing properly.

Bf NOTE: Be sure there is a 10.2-cm (4-inch) clearance at the back of the unit and above the monitor
to permit the required airflow.

Installing the Windows Operating System

The first time you turn on the computer, the operating system is installed automatically. This process
takes about 5 to 10 minutes, depending on which operating system is being installed. Carefully read
and follow the instructions on the screen to complete the installation.

/\ CAUTION: Once the automatic installation has begun, DO NOT TURN OFF THE COMPUTER
UNTIL THE PROCESS IS COMPLETE. Turning off the computer during the installation process may
damage the software that runs the computer or prevent its proper installation.

=’ NOTE: If the computer shipped with more than one operating system language on the hard drive,
the installation process could take up to 60 minutes.

If your computer was not shipped with a Microsoft operating system, some portions of this
documentation do not apply. Additional information is available in online help after you install the
operating system.

Installing the Windows Operating System
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Downloading Microsoft Windows Updates

1. To set up your Internet connection, click Start > Internet Explorer and follow the instructions on
the screen.

2. Once an Internet connection has been established, click the Start button.
3. Select the All Programs menu.
4. Click on the Windows Update link.

In Windows Vista and Windows 7, the Windows Update screen appears. Click view available
updates and make sure all critical updates are selected. Click the Install button and follow the
instructions on the screen.

In Windows XP, you will be directed to the Microsoft Windows Update Web site. If you see
one or more pop-up windows that ask you to install a program from http://www.microsoft.com,
click Yes to install the program. Follow the instructions on the Microsoft Web site to scan for
updates and install critical updates and service packs.

It is recommended that you install all of the critical updates and service packs.

5. After the updates have been installed, Windows will prompt you to reboot the machine. Be sure
to save any files or documents that you may have open before rebooting. Then select Yes to
reboot the machine.

Installing or Upgrading Device Drivers (Windows
systems)

When installing optional hardware devices after the operating system installation is complete, you
must also install the drivers for each of the devices.

If prompted for the i386 directory, replace the path specification with C:\1386, or use the Browse
button in the dialog box to locate the i386 folder. This action points the operating system to the
appropriate drivers.

Obtain the latest support software, including support software for the operating system from
http://www.hp.com/support. Select your country and language, select Download drivers and
software (and firmware), enter the model number of the computer, and press Enter.

Customizing the Monitor Display (Windows systems)

If you wish, you can select or change the monitor model, refresh rates, screen resolution, color
settings, font sizes, and power management settings. To do so, right-click on the Windows Desktop,
then click Personalize in Windows Vista and Windows 7 or Properties in Windows XP to change
display settings. For more information, refer to the online documentation provided with the graphics
controller utility or the documentation that came with your monitor.

Chapter 1 Installing and Customizing the Software
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Launching Windows XP from Windows 7

Windows XP Mode for Windows 7 allows you to install and launch Windows XP applications from the
Windows 7 taskbar. This feature is available on some computer models only.

To set up from a pre-installed Windows 7 desktop, click Start > Windows Virtual PC > Virtual
Windows XP and follow the instructions on the screen.

Accessing Disk Image (ISO) Files

There are disk image files (ISO files) included on your PC that contain the installation software for
additional software. These CD image files are located in the folder C:\SWSetup\ISOs. Each .iso file
can be burned to CD media to create an installation CD. It is recommended that these disks be

created and the software installed in order to get the most from your PC. The software and image file
names are:

e Corel WIinDVD SD and BD - installation software for WinDVD — used to play DVD movies

e HP Insight Diagnostics OR Vision Diagnostics — software to perform diagnostic activities on your
PC

Launching Windows XP from Windows 7
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2 Computer Setup (F10) Utility

Computer Setup (F10) Utilities

Use Computer Setup (F10) Utility to do the following:

Change factory default settings.
Set the system date and time.

Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

Modify the boot order of bootable devices such as hard drives, diskette drives, optical drives, or
USB flash media devices.

Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run
during a Full Boot. You can set the system to:

O always Quick Boot (default);
O periodically Full Boot (from every 1 to 30 days); or
0 always Full Boot.

Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test
(POST) messages. Post Messages Disabled suppresses most POST messages, such as
memory count, product name, and other non-error text messages. If a POST error occurs, the
error is displayed regardless of the mode selected. To manually switch to Post Messages
Enabled during POST, press any key (except F1 through F12).

Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

Enter the Asset Tag or property identification number assigned by the company to this computer.

Enable the power-on password prompt during system restarts (warm boots) as well as during
power-on.

Establish a setup password that controls access to the Computer Setup (F10) Utility and the
settings described in this section.

Secure integrated 1/O functionality, including the serial, USB, or parallel ports, audio, or
embedded NIC, so that they cannot be used until they are unsecured.

Enable or disable removable media boot ability.

Chapter 2 Computer Setup (F10) Utility



Enable or disable legacy diskette write ability (when supported by hardware).

Solve system configuration errors detected but not automatically fixed during the Power-On Self-
Test (POST).

Replicate the system setup by saving system configuration information on diskette and restoring
it on one or more computers.

Execute self-tests on a specified ATA hard drive (when supported by drive).

Enable or disable DriveLock security (when supported by drive).

Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system.
To access the Computer Setup Utilities menu, complete the following steps:

1.

Turn on or restart the computer. If you are in Microsoft Windows, click Start > Shut Down >
Restart.

As soon as the computer is turned on, press F10 when the monitor light turns green to enter
Computer Setup. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press F10 at the appropriate time, you must restart the computer and
again press F10 when the monitor light turns green to access the utility.

Select your language from the list and press Enter.

A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security,
Power, and Advanced.

Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and
down) keys to select the option you want, then press Enter. To return to the Computer Setup
Utilities menu, press Esc.

To apply and save changes, select File > Save Changes and Exit.
e If you have made changes that you do not want applied, select Ignore Changes and Exit.

e Toreset to factory settings or previously saved default settings (some models), select
Apply Defaults and Exit. This option will restore the original factory system defaults.

/A CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup
(F10) changes because the CMOS could become corrupted. It is safe to turn off the computer only
after exiting the F10 Setup screen.

Table 2-1 Computer Setup (F10) Utility

Heading Table

File Computer Setup—File on page 6
Storage Computer Setup—Storage on page 7
Security Computer Setup—Security on page 9

Computer Setup (F10) Utilities



Table 2-1 Computer Setup (F10) Utility (continued)

Power Computer Setup—Power on page 15

Advanced Computer Setup—Advanced on page 16

Computer Setup—File

Ef NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 2-2 Computer Setup—File

Option Description

System Information Lists:
e  Product name
e  SKU number (some models)
e  Processor type/speed/stepping
e  Cache size (L1/L2) (dual core processors have this listed twice)
e Installed memory size/speed, number of channels (single or dual) (if applicable)
e Integrated MAC address for embedded, enabled NIC (if applicable)
e  System BIOS (includes family name and version)
e  Chassis serial number

e  Asset tracking number

About Displays copyright notice.

Set Time and Date Allows you to set system time and date.

Flash System ROM Allows you to update the system ROM with a BIOS image file located on a USB flash media
device or CD-ROM.

Replicated Setup Save to Removable Media
Saves system configuration, including CMOS, to a USB flash media device.
Restore from Removable Media

Restores system configuration from a USB flash media device.

Default Setup Save Current Settings as Default
Saves the current system configuration settings as the default.
Restore Factory Settings as Default

Restores the factory system configuration settings as the default.

Apply Defaults and Applies the currently selected default settings and clears any established passwords.
Exit

6 Chapter 2 Computer Setup (F10) Utility



Table 2-2 Computer Setup—File (continued)

Ignore Changes Exits Computer Setup without applying or saving any changes.

and Exit

Save Changes and Saves changes to system configuration or default settings and exits Computer Setup.
Exit

Computer Setup—Storage

Bf NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 2-3 Computer Setup—Storage

Option Description

Computer Setup (F10) Utilities 7
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Table 2-3 Computer Setup—Storage (continued)

Device Configuration

Lists all installed BIOS-controlled storage devices.

When a device is selected, detailed information and options are displayed. The following options
may be presented:

Hard Disk: Size, model, firmware, serial number, connector color, SMART, emulation type.
e None (prevents BIOS data accesses and disables it as a boot device)

e Hard Disk (treated as a hard disk)

CD-ROM: Model, firmware, serial number, connector color.

Translation Mode (ATA disks only)

Lets you select the translation mode to be used for the device. This enables the BIOS to access
disks partitioned and formatted on other systems and may be necessary for users of older
versions of UNIX (e.g., SCO UNIX version 3.2). Options are Automatic, Bit-Shift, LBA Assisted,
User, and Off.

CAUTION: Ordinarily, the translation mode selected automatically by the BIOS should not be
changed. If the selected translation mode is not compatible with the translation mode that was
active when the disk was partitioned and formatted, the data on the disk will be inaccessible.

Default Values (ATA disks only)
NOTE: This feature appears only when User translation mode is selected.

Allows you to specify the parameters (logical cylinders, heads, and sectors per track) used by the
BIOS to translate disk I/O requests (from the operating system or an application) into terms the
hard drive can accept. Logical cylinders may not exceed 1024. The number of heads may not
exceed 256. The number of sectors per track may not exceed 63. These fields are only visible
and changeable when the drive translation mode is set to User.

SATA Defaults
Translation Mode (ATA disks only)

Lets you select the translation mode to be used for the device. This enables the BIOS to access
disks partitioned and formatted on other systems and may be necessary for users of older
versions of UNIX (e.g., SCO UNIX version 3.2). Options are Automatic, Bit-Shift, LBA Assisted,
User, and Off.

CAUTION: Ordinarily, the translation mode selected automatically by the BIOS should not be
changed. If the selected translation mode is not compatible with the translation mode that was
active when the disk was partitioned and formatted, the data on the disk will be inaccessible.

Chapter 2 Computer Setup (F10) Utility



Table 2-3 Computer Setup—Storage (continued)

Storage Options Removable Media Boot
Enables/disables ability to boot the system from removable media.
Max SATA Speed

Allows you to choose 1.5 Gbps or 3.0 Gpbs as the maximum SATA speed. By default, the speed
is limited to 1.5 Gbps for maximum reliability.

SATA Emulation

Allows you to choose how the SATA controller and devices are accessed by the operating
system. Supported options: IDE and AHCI.

IDE - This is the most backwards-compatible setting of the three options. Operating systems
usually do not require additional driver support in IDE mode.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take
advantage of more advanced features of the SATA controller.

DPS Self-Test Allows you to execute self-tests on ATA hard drives capable of performing the Drive Protection
System (DPS) self-tests.

NOTE: This selection will only appear when at least one drive capable of performing the DPS
self-tests is attached to the system.

Boot Order Allows you to:

e Specify the order in which attached devices (such as a USB flash media device, hard drive,
optical drive, or network interface card) are checked for a bootable operating system image.
Each device on the list may be individually excluded from or included for consideration as a
bootable operating system source.

e  Specify the order of attached hard drives. The first hard drive in the order will have priority in
the boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating
system has started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press F9 when the monitor light turns green. After POST is completed, a list of
bootable devices is displayed. Use the arrow keys to select the preferred bootable device and
press Enter. The computer then boots from the selected non-default device for this one time.

Computer Setup—Security

Bf NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 2-4 Computer Setup—Security

Option Description

Computer Setup (F10) Utilities 9
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Table 2-4 Computer Setup—Security (continued)

Setup Password

Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.

See the Desktop Management Guide for more information.

Power-On Password

Allows you to set and enable a power-on password. The power-on password prompt appears
after a power cycle. If the user does not enter the correct power-on password, the unit will not
boot.

NOTE: This password does not appear on warm boots, such as Ctrl+Alt+Delete or Restart from
Windows, unless enabled in Password Options (see below).

See the Desktop Management Guide for more information.

Password Options

(This selection appears
only if a power-on
password or setup
password is set.)

Allows you to enable/disable:

e Lock Legacy Resources (appears if a setup password is set)

e Network Server Mode (appears if a power-on password is set)

e  Password Prompt on Warm Boot (Ctrl+Alt+Delete) (appears if a power-on password is set)

e  Setup Browse Mode (appears if a setup password is set) (allows viewing, but not changing,
the F10 Setup Options without entering setup password)

e  Stringent Password (appears if a power-on password is set), which when enabled bypasses
the onboard password jumper to disable the power-on password.

e  Password prompt on F9, F11, & F12 (allows access to menus without entering setup
password)

See the Desktop Management Guide for more information.

Smart Cover (some
models)

Allows you to:
e  Lock/unlock the Cover Lock.
e  Set the Cover Removal Sensor to Disable/Notify User/Setup Password.

NOTE: Notify User alerts the user that the sensor has detected that the cover has been
removed. Setup Password requires that the setup password be entered to boot the computer if
the sensor detects that the cover has been removed.

This feature is supported on some models only. See the Desktop Management Guide for more
information.
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Table 2-4 Computer Setup—Security (continued)

Device Security

Allows you to set Device Available/Device Hidden for:

Serial ports

Parallel port

System audio

Network controllers (some models)
Embedded security device (some models)
SATAO

SATA1

USB Security

Allows you to set Device Available/Device Hidden for:

Front USB Ports

° USB Port 3
° USB Port 4
° USB Port 5
° USB Port 6

Rear USB Ports

o USBPort9

o USB Port 10

o USB Port 11

o USB Port 12
Accessory USB Ports
o USB Port 1

° USB Port 2

Slot Security

Allows you to disable any PCI or PCI Express slot

Network Service Boot

Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only; the network controller must be either a PCI
expansion card or embedded on the system board.)

System IDs

Allows you to set:

Asset tag (18-byte identifier), a property identification number assigned by the company to
the computer.

Ownership tag (80-byte identifier) displayed during POST.

Chassis serial number or Universal Unique Identifier (UUID) number. The UUID can only be
updated if the current chassis serial number is invalid. (These ID numbers are normally set in
the factory and are used to uniquely identify the system.)

Keyboard locale setting (for example, English or German) for System ID entry.

Computer Setup (F10) Utilities 11



Table 2-4 Computer Setup—Security (continued)

DriveLock Security Allows you to assign or modify a master or user password for hard drives. When this feature is
enabled, the user is prompted to provide one of the DriveLock passwords during POST. If neither
is successfully entered, the hard drive will remain inaccessible until one of the passwords is
successfully provided during a subsequent cold-boot sequence.

NOTE: This selection will only appear when at least one drive that supports the DriveLock
feature is attached to the system.

See the Desktop Management Guide for more information.
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Table 2-4 Computer Setup—Security (continued)

System Security
(some models: these
options are hardware
dependent)

Data Execution Prevention (some models) (enable/disable) - Helps prevent operating system
security breaches.

PAVP (Models with Blu-ray drives) (disabled/min/max) - PAVP enables the Protected Audio Video
Path in the Chipset. This may allow viewing of some protected high definition content that would
otherwise be prohibited from playback. Selecting Max will assign 96 Megabytes of system
memory exclusively to PAVP.

Virtualization Technology (some models) (enable/disable) - Controls the virtualization features of
the processor. Changing this setting requires turning the computer off and then back on.

Virtualization Technology Directed 1/0O (some models) (enable/disable) - Controls virtualization
DMA remapping features of the chipset. Changing this setting requires turning the computer off
and then back on.

Trusted Execution Technology (some models) (enable/disable) - Controls the underlying
processor and chipset features needed to support a virtual appliance. Changing this setting
requires turning the computer off and then back on. To enable this feature you must enable the
following features:

e Embedded Security Device Support
e  Virtualization Technology
e Virtualization Technology Directed I/O

Embedded Security Device Support (some models) (enable/disable) - Permits activation and
deactivation of the Embedded Security Device. Changing this setting requires turning the
computer off and then back on.

NOTE: To configure the Embedded Security Device, a Setup password must be set.

e Reset to Factory Settings (some models) (Do not reset/Reset) - Resetting to factory defaults
will erase all security keys. Changing this setting requires turning the computer off and then
back on.

CAUTION: The embedded security device is a critical component of many security
schemes. Erasing the security keys will prevent access to data protected by the Embedded
Security Device. Choosing Reset to Factory Settings may result in significant data loss.

OS management of Embedded Security Device (some models) (enable/disable) - This option
allows the user to limit operating system control of the Embedded Security Device. Changing this
setting requires turning the computer off and then back on. This option allows the user to limit OS
control of the Embedded Security Device.

e Reset of Embedded Security Device through OS (some models) (enable/disable) - This
option allows the user to limit the operating system ability to request a Reset to Factory
Settings of the Embedded Security Device. Changing this setting requires turning the
computer off and then back on.

NOTE: To enable this option, a Setup password must be set.
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Table 2-4 Computer Setup—Security (continued)

Master Boot Record
Security

Protects the master boot record from viruses or other corruption. Saves of copy of the current
master boot record.

Setup Security Level

Provides a method to allow end-users limited access to change specified setup options, without
having to know the Setup Password.

This feature allows the administrator the flexibility to protect changes to essential setup options,
while allowing the user to view system settings and configure nonessential options. The
administrator specifies access rights to individual setup options on a case-by-case basis via the
Setup Security Level menu. By default, all setup options are assigned Setup Password, indicating
the user must enter the correct Setup Password during POST to make changes to any of the
options. The administrator may set individual items to None, indicating the user can make
changes to the specified options when setup has been accessed with invalid passwords. The
choice, None, is replaced by Power-On Password if a Power-On Password is enabled.

NOTE: Setup Browse Mode must be set to Enable in order for the user to enter Setup without
knowing the setup password.
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Computer Setup—Power

Bf NOTE: Support for specific Computer Setup options may vary depending on the hardware

configuration.

Table 2-5 Computer Setup—Power

Option Description
OS Power e Runtime Power Management— Enable/Disable. Allows certain operating systems to reduce
Management processor voltage and frequency when the current software load does not require the full

capabilities of the processor.

Idle Power Savings—Extended/Normal. Allows certain operating systems to decrease the
processors power consumption when the processor is idle.

ACPI S3 Hard Disk Reset—Enabling this causes the BIOS to ensure hard disks are ready to
accept commands after resuming from S3 before returning control to the operating system.

ACPI S3 PS2 Mouse Wakeup—Enables or disables waking from S3 due to any PS2 mouse
activity or a button click only.

USB Wake on Device Insertion (some models)—Allows system to wake from Standby on
USB device insertion.

Unique Sleep State Blink Rates—Enable/Disable. This feature is designed to provide a
visual indication of what sleep state the system is in. Each sleep state has a unique blink
pattern.

° S0 = Solid green LED.

° S3 = 3 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds (green LED) —
repeated cycles of 3 blinks and a pause.

° S4 = 4 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds (green LED) —
repeated cycles of 4 blinks and a pause.

° S5 =LED is off.

NOTE: If this feature is disabled, S4 and S5 both have the LED off. S1 (no longer
supported) and S3 use 1 blink per second.

Hardware Power

S5 Maximum Power Savings—Turns off power to all nonessential hardware when system is off to

Management meet EUP Lot 6 requirement of less than 1 Watt power usage.
SATA Power Management enables or disables SATA bus and/or device power management.
Thermal Fan idle mode—This bar graph controls the minimum permitted fan speed.

NOTE: This setting only changes the minimum fan speed. The fans are still automatically
controlled.

Computer Setup (F10) Utilities
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Computer Setup—Advanced

Bf NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table 2-6 Computer Setup—Advanced (for advanced users)

Option Heading

Power-On Options Allows you to set:
e POST mode (QuickBoot, Clear Memory, FullBoot, or FullBoot Every x Days).
QuickBoot = Do not clear memory or perform a memory test.

FullBoot = Memory test (count) on cold boot. Clears memory on all boots.
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Table 2-6 Computer Setup—Advanced (for advanced users) (continued)

° Clear Memory = No memory count on cold boot. Clears memory on all boots.

° FullBoot Every x Days = Memory count on 1st cold boot on or after the xth day. No
more memory counts until 1st cold boot on or after x days. Clears memory on all boots.

e POST messages (enable/disable).

e  F9 prompt (hidden/displayed). Enabling this feature will display the text F9 = Boot Menu
during POST. Disabling this feature prevents the text from being displayed. However,
pressing F9 will still access the Shortcut Boot [Order] Menu screen. See Storage > Boot
Order for more information.

e  F10 prompt (hidden/displayed). Enabling this feature will display the text F10 = Setup during
POST. Disabling this feature prevents the text from being displayed. However, pressing F10
will still access the Setup screen.

e F11 prompt (hidden/displayed). Setting this feature to displayed will display the text F11 =
Recovery during POST. Hiding the feature prevents the text from being displayed. However,
pressing F11 will still attempt to boot to the HP Backup and Recovery partition. See Factory
Recovery Boot Support for more information.

e F12 prompt (hidden/displayed). Enabling this feature will display the text F12 = Network
during POST. Disabling this feature prevents the text from being displayed. However,
pressing F12 will still force the system to attempt booting from the network.

e  Factory Recovery Boot Support (enable/disable). Enabling this feature will cause an
additional prompt, F11 = Recovery, to be displayed during POST on systems with
HP Backup and Recovery software installed and configured with a recovery partition on the
boot hard drive. Pressing F11 causes the system to boot to the recovery partition and launch
HP Backup and Recovery. The F11 = Recovery prompt can be hidden with the F11 prompt
(hidden/displayed) option (see above).

e  Option ROM Prompt (enable/disable). Enabling this feature will cause the system to display
a message before loading option ROMs. (This feature is supported on some models only.)

e Remote Wakeup Boot Source (remote server/local hard drive).
e  After Power Loss (off/on/previous state): Setting this option to:
° Off—causes the computer to remain powered off when power is restored.
° On—causes the computer to power on automatically as soon as power is restored.

° Previous state—causes the computer to power on automatically as soon as power is
restored, if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be
able to use the suspend/sleep feature or the Remote Management features.

e POST Delay (None, 5, 10 15, or 20 seconds). Enabling this feature will add a user-specified
delay to the POST process. This delay is sometimes needed for hard disks on some PCI
cards that spin up very slowly, so slowly that they are not ready to boot by the time POST is
finished. The POST delay also gives you more time to select F10 to enter Computer (F10)
Setup.

e Bypass F1 Prompt on Configuration Changes (Enable/Disable). Allows you to set the
computer not to confirm when changes were made.

Execute Memory Test
(some models)

Restarts the computer and executes the POST memory test/logging.

Computer Setup (F10) Utilities
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Table 2-6 Computer Setup—Advanced (for advanced users) (continued)

BIOS Power-On

Allows you to set the computer to turn on automatically at a time you specify.

Onboard Devices

Allows you to set resources for or disable onboard system devices (diskette controller, serial port,
or parallel port).

PCI Devices e Lists currently installed PCI devices and their IRQ settings.
e Allows you to reconfigure IRQ settings for these devices or to disable them entirely. These
settings have no effect under an ACPI-based operating system.
PCI VGA Displayed only if there are multiple PCI video adapters in the system. Allows you to specify which

Configuration

VGA controller will be the “boot” or primary VGA controller.

NOTE: In order to see this entry, you must enable Integrated Video (Advanced > Device
Options) and Save Changes and Exit.

Bus Options

On some models, allows you to enable or disable:
e PCI SERR# Generation.

e PCI VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration
space; only needed when more than one graphics controller is installed.

Device Options

Allows you to set:

e  Printer mode (Bi-Directional, EPP + ECP, Output Only).
e  Num Lock State at Power-On (off/on).

e S5 Wake on LAN (enable/disable).

o To disable Wake on LAN during the off state (S5), use the arrow (left and right) keys to
select the Advanced > Device Options menu and set the S5 Wake on LAN feature to
Disable. This obtains the lowest power consumption available on the computer during
S5. It does not affect the ability of the computer to Wake on LAN from suspend or
hibernation, but will prevent it from waking from S5 via the network. It does not affect
operation of the network connection while the computer is on.

° If a network connection is not required, completely disable the network controller (NIC)
by using the arrow (left and right) keys to select the Security > Device Security menu.
Set the Network Controller option to Device Hidden. This prevents the network
controller from being used by the operating system and reduces the power used by the
computer in S5.

° Multi-Processor (enable/disable). This option may be used to disable multi-processor support
under the OS.

e Internal Speaker (some models) (does not affect external speakers).

e NIC Option ROM Download (enable/disable). The BIOS contains an embedded NIC option
ROM to allow the unit to boot through the network to a PXE server. This is typically used to
download a corporate image to a hard drive. The NIC option ROM takes up memory space
below 1MB commonly referred to as DOS Compatibility Hole (DCH) space. This space is
limited. This F10 option will allow users to disable the downloading of this embedded NIC
option ROM thus giving more DCH space for additional PCI cards which may need option
ROM space. The default will be to have the NIC option-ROM-enabled.
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Table 2-6 Computer Setup—Advanced (for advanced users) (continued)

Management Devices = The Management Devices menu will only be displayed in the Advanced menu when the BIOS
detects multiple management options.

This option is for installed NIC cards that support ASF or DASH. Use the Management Devices
menu to select if the BIOS management operations will be through the embedded solution or one
of the installed NIC cards.

Management Allows you to set:

Operations
e MEBXx Setup Prompt (enable/disable). Enabling this feature displays the CTRL+P prompt

during POST. Disabling this feature prevents the prompt from being displayed. However,
pressing Ctrl+P still accesses the utility used to configure manageability settings.

The CTRL+P function activates the MEBx Setup menu. If the Setup Password is configured,
the user will be prompted to correctly enter it before being allowed to enter the MEBx Setup.
It the password is entered incorrectly three times, the MEBx Setup will not be activated.

e Intel Remote PC Assist Prompt (Hidden/Displayed). Displaying this feature displays the
CTRL+ALT+F1 prompt during POST. Hiding this feature prevents the prompt from being
displayed. However, pressing Ctrl+Alt+F1 still accesses the utility used to attempt to connect
to remote help server or services.

° Intel PC Assist Timeout (5, 10, 15, 20, 30, 40, 50, 60, 120, 180, 240 seconds). Allows the
user/administrator is set a time limit for Remote Help to establish contact with a remote
server when initiated.

e  SOL Terminal Emulation Mode. Selects between VT100 and ANSI SOL terminal emulation.
SOL terminal emulation mode is only activated during remote AMT redirection operations.
The emulation options allow administrators to select which mode works best with their
console.

e  SOL Local Keyboard (enable/disable). Disable or enable client keyboard during SOL
sessions. Some remote remediation may involve having the local client boot a remote image
provided by an administrator. This option determines if the BIOS will keep the local keyboard
enabled or disabled for possible local client interaction. If the local keyboard is disabled, all
keyboard input is only accepted from the remote source.

e Unprovision AMT on next boot. Allows reset of AMT settings.

Recovering the Configuration Settings

This method of recovery requires that you first perform the Save to Removable Media command
with the Computer Setup (F10) Utility before Restore is needed. (See Save to Removable Media
on page 6 in the Computer Setup—File table.)

NOTE: Itis recommended that you save any modified computer configuration settings to a diskette,
a USB flash media device, or a diskette-like device (a storage device set to emulate a diskette drive)
and save the diskette or device for possible future use.

To restore the configuration, insert the diskette, USB flash media device, or other storage media
emulating a diskette with the saved configuration and perform the Restore from Removable Media
command with the Computer Setup (F10) Utility. (See Restore from Removable Media on page 6 in
the Computer Setup—File table.)

Recovering the Configuration Settings

19



3 Serial ATA (SATA) Drive Guidelines
and Features

B NOTE: HP only supports the use of SATA hard drives on these models of computer. No Parallel
ATA (PATA) drives are supported.

SATA Hard Drives

Serial ATA Hard Drive Characteristics

Number of pins/conductors in data cable 77

Number of pins in power cable 15

Maximum data cable length 39.37 in (100 cm)
Data interface voltage differential 400-700 mV
Drive voltages 33V,5V,12V
Jumpers for configuring drive N/A

Data transfer rate 3.0 Gb/s

SATA Hard Drive Cables

SATA Data Cable

Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the SATA
1.5 Gb/s drives.

Current HP desktop products ship with SATA 3.0 Gb/s hard drives.

SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and
never bend it tighter than a 30 mm (1.18 in) radius.

The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive.
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SMART ATA Drives

The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal
Computers have built-in drive failure prediction that warns the user or network administrator of an
impending failure or crash of the hard drive. The SMART drive tracks fault prediction and failure
indication parameters such as reallocated sector count, spin retry count, and calibration retry count. If
the drive determines that a failure is imminent, it generates a fault alert.

Hard Drive Capacities

The combination of the file system and the operating system used in the computer determines the
maximum usable size of a drive partition. A drive partition is the largest segment of a drive that may
be properly accessed by the operating system. A single hard drive may therefore be subdivided into a
number of unique drive partitions in order to make use of all of its space.

Because of the differences in the way that drive sizes are calculated, the size reported by the
operating system may differ from that marked on the hard drive or listed in the computer specification.
Drive size calculations by drive manufacturers are bytes to the base 10 while calculations by
Microsoft are bytes to the base 2.

Drive/Partition Capacity Limits

Maximum Size

File System Controller Type Operating System Partition Drive
FAT 32 ATA Windows XP/Windows Vista/Windows 7 32GB 2TB
NTFS ATA Windows XP/Windows Vista/Windows 7 2TB 2TB
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4 Identifying the Chassis, Routine Care,
and Disassembly Preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.

/A CAUTION: When the computer is plugged into an AC power source, voltage is always applied to
the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.

Chassis Designations

Small Form Factor (SFF)

Figure 4-1 Small Form Factor chassis
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Electrostatic Discharge Information

A sudden discharge of static electricity from your finger or other conductor can destroy static-
sensitive devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An
electronic device exposed to electrostatic discharge (ESD) may not appear to be affected at all and
can work perfectly throughout a normal cycle. The device may function normally for a while, but it has
been degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the
discharge contains enough power to alter device parameters or melt silicon junctions.

Generating Static
The following table shows that:
e Different activities generate different amounts of static electricity.

e  Static electricity increases as humidity decreases.

Relative Humidity

Event 55% 40% 10%
Walking across carpet 7,500 V 15,000 V 35,000 V
Walking across vinyl floor 3,000 V 5,000 V 12,000 V
Motions of bench worker 400 V 800V 6,000 V
Removing DIPs from plastic tube 400 V 700 V 2,000V
Removing DIPs from vinyl tray 2,000 V 4,000 V 11,500 V
Removing DIPs from Styrofoam 3,500 V 5,000 V 14,500 V
Removing bubble pack from PCB 7,000V 20,000 V 26,500 V
Packing PCBs in foam-lined box 5,000 V 11,000 V 21,000 V

These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

Bf NOTE: 700 volts can degrade a product.

Preventing Electrostatic Damage to Equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the
degree of sensitivity. The following packaging and grounding precautions are necessary to prevent
damage to electric components and accessories.

e To avoid hand contact, transport products in static-safe containers such as tubes, bags, or
boxes.

e Protect all electrostatic parts and assemblies with conductive or approved containers or
packaging.
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Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.
Place items on a grounded surface before removing them from their container.

Always be properly grounded when touching a sensitive component or assembly.

Avoid contact with pins, leads, or circuitry.

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or
conductive foam.

Personal Grounding Methods and Equipment

Use the following equipment to prevent static electricity damage to equipment:

Wrist straps are flexible straps with a maximum of one-megohm + 10% resistance in the ground
cords. To provide proper ground, a strap must be worn snug against bare skin. The ground cord
must be connected and fit snugly into the banana plug connector on the grounding mat or
workstation.

Heel straps/Toe straps/Boot straps can be used at standing workstations and are compatible
with most types of shoes or boots. On conductive floors or dissipative floor mats, use them on
both feet with a maximum of one-megohm = 10% resistance between the operator and ground.

Static Shielding Protection Levels

Method Voltage
Antistatic plastic 1,500
Carbon-loaded plastic 7,500
Metallized laminate 15,000

Grounding the Work Area

To prevent static damage at the work area, use the following precautions:

Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

Use static-dissipative mats, foot straps, or air ionizers to give added protection.

Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at static-free work areas.

Turn off power and input signals before inserting and removing connectors or test equipment.

Use fixtures made of static-safe materials when fixtures must directly contact dissipative
surfaces.

Keep work area free of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.
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Recommended Materials and Equipment

Materials and equipment that are recommended for use in preventing static electricity include:

Antistatic tape

Antistatic smocks, aprons, or sleeve protectors

Conductive bins and other assembly or soldering aids

Conductive foam

Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance
Static-dissipative table or floor mats with hard tie to ground

Field service kits

Static awareness labels

Wrist straps and footwear straps providing one-megohm +/- 10% resistance
Material handling packages

Conductive plastic bags

Conductive plastic tubes

Conductive tote boxes

Opaque shielding bags

Transparent metallized shielding bags

Transparent shielding tubes

Operating Guidelines

To prevent overheating and to help prolong the life of the computer:

Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and
cold.

Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all
vented sides of the computer and above the monitor to permit the required airflow.

Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign
matter can block the vents and limit the airflow. Be sure to unplug the computer before cleaning
the air vents.

Never operate the computer with the cover or side panel removed.

Operating Guidelines

25



e Do not stack computers on top of each other or place computers so near each other that they
are subject to each other’s re-circulated or preheated air.

e Ifthe computer is to be operated within a separate enclosure, intake and exhaust ventilation
must be provided on the enclosure, and the same operating guidelines listed above will still

apply.
e Keep liquids away from the computer and keyboard.
e Never cover the ventilation slots on the monitor with any type of material.

e Install or enable power management functions of the operating system or other software,
including sleep states.

Routine Care

General Cleaning Safety Precautions
1. Never use solvents or flammable solutions to clean the computer.

2.  Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and
then use the cloth on the component.

3. Always unplug the computer when cleaning with liquids or damp cloths.
4. Always unplug the computer before cleaning the keyboard, mouse, or air vents.
5. Disconnect the keyboard before cleaning it.

6. Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the Computer Case

Follow all safety precautions in General Cleaning Safety Precautions on page 26 before cleaning the
computer.

To clean the computer case, follow the procedures described below:
e Toremove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

e  For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

e  For stubborn stains, use isopropy! (rubbing) alcohol. No rinsing is needed as the alcohol will
evaporate quickly and not leave a residue.

e After cleaning, always wipe the unit with a clean, lint-free cloth.

e Occasionally clean the air vents on the computer. Lint and other foreign matter can block the
vents and limit the airflow.
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Cleaning the Keyboard

Follow all safety precautions in General Cleaning Safety Precautions on page 26 before cleaning the
keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the
Computer Case on page 26.

When cleaning debris from under the keys, review all rules in General Cleaning Safety Precautions
on page 26 before following these procedures:

/A CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from
under the keys.

e Visible debris underneath or between the keys may be removed by vacuuming or shaking.

e Canned, pressurized air may be used to clean debris from under the keys. Caution should be
used as too much air pressure can dislodge lubricants applied under the wide keys.

e If you remove a key, use a specially designed key puller to prevent damage to the keys. This
tool is available through many electronic supply outlets.

/A CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these
keys are improperly removed or installed, the keyboard may not function properly.

e Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed
out. Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers to
remove any fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the Monitor

e  Wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for
cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into
the housing and damage a component. Never use solvents or flammable liquids on the monitor.

e To clean the monitor body follow the procedures in Cleaning the Computer Case on page 26.

Cleaning the Mouse
Before cleaning the mouse, ensure that the power to the computer is turned off.

e Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out
any debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

e To clean the mouse body, follow the procedures in Cleaning the Computer Case on page 26.

Service Considerations

Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.
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Power Supply Fan

The power supply fan is a variable-speed fan based on the temperature in the power supply.

/A CAUTION: The cooling fan is always on when the computer is in the “On” mode. The cooling fan is
off when the computer is in “Standby,” “Suspend,” or “Off’ modes.

You must disconnect the power cord from the power source before opening the computer to prevent
system board or component damage.

Tools and Software Requirements

To service the computer, you need the following:

Screws

Torx T-15 screwdriver (HP screwdriver with bits, PN 161946-001)

Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)
Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)
Phillips #2 screwdriver

Diagnostics software

HP tamper-resistant T-15 wrench (Smart Cover FailSafe Key, PN 166527-001) or HP tamper-
resistant bits (Smart Cover FailSafe Key, PN 166527-002)

The screws used in the computer are not interchangeable. They may have standard or metric threads
and may be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with
the part that was removed, then returned to their proper locations.

/A CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard
drives only.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the
work area to prevent damage.

Cables and Connectors
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Most cables used throughout the unit are flat, flexible cables. These cables must be handled with
care to avoid damage. Apply only the tension required to seat or unseat the cables during insertion or
removal from the connector. Handle cables by the connector whenever possible. In all cases, avoid
bending or twisting the cables, and ensure that the cables are routed in such a way that they cannot
be caught or snagged by parts being removed or replaced.

/A CAUTION: When servicing this computer, ensure that cables are placed in their proper location
during the reassembly process. Improper cable placement can damage the computer.
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Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This
applies to failed drives as well as replacement spares.

e If adrive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

e Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the CPU.

e Avoid dropping drives from any height onto any surface.

e If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive
while the computer is on or in standby mode.

e Before handling a drive, ensure that you are discharged of static electricity. While handling a
drive, avoid touching the connector. For more information about preventing electrostatic
damage, refer to Electrostatic Discharge Information on page 23

e Do not use excessive force when inserting a drive.

e Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic
fields such as monitors or speakers.

Lithium Coin Cell Battery

A

The battery that comes with the computer provides power to the real-time clock and has a minimum
lifetime of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this
guide for instructions on the replacement procedures.

WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose
in water or fire, or expose it to temperatures higher than 140°F (60°C). Do not attempt to recharge the
battery.

NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste. In order to forward them to recycling or proper disposal, please use the
public collection system or return them to HP, their authorized partners, or their agents.

Service Considerations
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5 Illlustrated parts catalog

This chapter provides parts information for the chassis.

Spare parts

Computer major components
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Item Description Spare part number
(1) Access panel 636924-001
(2) Front bezel 636920-001
(3) Power supply
240W, 85% efficiency 613663-001
240W, High Voltage protection 613664-001
240W 613763-001
(4) Speaker, internal 636925-001
(5) System board (includes replacement thermal material)
Standard system board 608748-001
Netclone 640126-001
(6) Chassis fan 636922-001
(7) Baffle 636921-001
(8) Heat sink (includes replacement thermal material) 636919-001
(9) Front I/0 and power switch assembly 636926-001
Cables
(10) SATA power cable 636923-001
(11) SATA cable, 1 straight end, 1 angled end (25 inch; 365 mm) 638814-001
(12) SATA cable, 2 straight ends 19-inch; 483 mm) 638813-001
Memory modules (PC3-10600, 1333-MHz)
4-MB 585157-001
2-GB 635803-001
1-GB 635802-001
Hard drives
1-TB 636930-001
500-GB 636929-001
320-GB 636928-001
250-GB 636927-001
Optical drives
6X BD-Writer SuperMulti drive with LightScribe 617030-001
16X DVD+RW SuperMulti drive with LightScribe 615646-001
16X DVD-ROM drive 581058-001

Expansion cards

Spare parts
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Item Description Spare part number
ATI HD6350, 512-MB PCle x16 graphics card 637995-001
nVidia Quadro NVS300 PCle x1 graphics card 632827-001
nVidia Quadro NVS300 PCle x16 graphics card 632486-001
Keyboard
NOTE: For a list of supported countries and associated dash numbers, see Sequential
part number listing on page 33.

HP PS/2 537745-xxx
HP USB 537746-xxx
USB SmartCard 631411-xxx
USB Mini 535873-xxx
Washable 577495-xxx
Processors (include replacement thermal material)

Intel Celeron Processors

e E3500, 1-MB cache, 2.70 GHz 633219-001
e E3400, 1-MB cache, 2.60 GHz 602071-001
e E3300, 1-MB cache, 2.50 GHz 585886-001
Intel Core 2 Quad Processors

e Q9550s, 2.83 GHz, 12-MB L2 cache 593228-001
e Q9505s, 2.83 GHz, 6-MB L2 cache (95W) 593229-001
Intel Core 2 Duo Processors

e EB8600, 6-MB cache, 3.33 GHz 497732-001
e E8500, 6-MB cache, 3.16 GHz 466170-001
e EB8400, 6-MB cache, 3.00 GHz 509554-001
e E7600, 3-MB cache, 3.06 GHz 573954-001
e EB6800, 2-MB cache, 3.33 GHz 631758-001
e EB6700, 2-MB cache, 3.20 GHz, 1066-MHz FSB 617840-001
e E5800, 2-MB cache, 3.20 GHz, 800-MHz FSB 646376-001
Mouse

PS2, optical, black 537748-001
USB, optical, black 537749-001
USB, laser, black (not illustrated) 570580-001
Washable 619580-001
Bezel blank
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Item Description Spare part number
5.25-inch 570838-001
3.5-inch 583653-001
Ports
Printer 638817-001
Serial 638815-001
Card reader, 22-in-1 636166-001
USB Speakers, external 609249-001
Hood sensor 638816-001
Rubber Feet Kit 583654-001
Chassis stand 587451-001

Sequential part number listing

Spare part Description

number

466170-001 Intel Core2 Duo E8500 processor, 6-MB cache, 3.16 GHz
497732-001 Intel Core2 Duo E8600 processor , 6-MB cache, 3.33 GHz
509554-001 Intel Core2 Duo E8400 processor, 6-MB cache, 3.00 GHz
535873-001 Keyboard, USB, mini, the United States

535873-121 Keyboard, USB, mini, French Canada

537745-001 Keyboard, PS/2, the United States

537745-031 Keyboard, PS/2, the United Kingdom

537745-041 Keyboard, PS/2, Germany

537745-051 Keyboard, PS/2, France

537745-061 Keyboard, PS/2, Italy

537745-071 Keyboard, PS/2, Spain

537745-081 Keyboard, PS/2, Denmark

537745-091 Keyboard, PS/2, Norway

537745-101 Keyboard, PS/2, Sweden

537745-111 Keyboard, PS/2, Switzerland

537745-121 Keyboard, PS/2, French Canada

537745-131 Keyboard, PS/2, Portugal

537745-141 Keyboard, PS/2, Turkey

Spare parts
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Spare part
number

Description

537745-151

Keyboard, PS/2, Greece

537745-161

Keyboard, PS/2, Latin America

537745-171

Keyboard, PS/2, Saudi Arabia

537745-181

Keyboard, PS/2, Belgium

537745-201

Keyboard, PS/2, Brazil

537745-211

Keyboard, PS/2, Hungary

537745-221

Keyboard, PS/2, the Czech Republic

537745-231

Keyboard, PS/2, Slovakia

537745-241

Keyboard, PS/2, Poland

537745-251

Keyboard, PS/2, Russia

537745-261

Keyboard, PS/2, Bulgaria

537745-281

Keyboard, PS/2, Belarus

537745-331

Keyboard, PS/2, the Netherlands

537745-351

Keyboard, PS/2, Finland

537745-541

Keyboard, PS/2, Turkey F

537745-AA1

Keyboard, PS/2, Simplified Chinese

537745-AB1

Keyboard, PS/2, Taiwan

537745-AC1

Keyboard, PS/2, Hong Kong

537745-B31

Keyboard, PS/2, International English

537745-B41

Keyboard, PS/2, BHCSY

537745-BB1

Keyboard, PS/2, Israel

537745-BL1

Keyboard, PS/2, BHCSY

537745-CA1

Keyboard, PS/2, Estonia

537745-DD1

Keyboard, PS/2, Iceland

537745-DE1

Keyboard, PS/2, Arab

537745-DF1

Keyboard, PS/2, Kazakstan

537745-KD1

Keyboard, PS/2, South Korea

537745-L31

Keyboard, PS/2, International

537746-001

Keyboard, USB, the United States

537746-031

Keyboard, USB, the United Kingdom

537746-041

Keyboard, USB, Germany

537746-051

Keyboard, USB, France
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Spare part Description

number

537746-061 Keyboard, USB, ltaly
537746-071 Keyboard, USB, Spain
537746-081 Keyboard, USB, Denmark
537746-091 Keyboard, USB, Norway
537746-101 Keyboard, USB, Sweden
537746-111 Keyboard, USB, Switzerland
537746-121 Keyboard, USB, French Canada
537746-131 Keyboard, USB, Portugal
537746-141 Keyboard, USB, Turkey
537746-151 Keyboard, USB, Greece
537746-161 Keyboard, USB, Latin America
537746-171 Keyboard, USB, Saudi Arabia
537746-181 Keyboard, USB, Belgium
537746-201 Keyboard, USB, Brazil
537746-211 Keyboard, USB, Hungary
537746-221 Keyboard, USB, the Czech Republic
537746-231 Keyboard, USB, Slovakia
537746-241 Keyboard, USB, Poland
537746-251 Keyboard, USB, Russia
537746-281 Keyboard, USB, Belarus
537746-331 Keyboard, USB, the Netherlands
537746-351 Keyboard, USB, Finland
537746-541 Keyboard, USB, Turkey F
537746-AA1 Keyboard, USB, Simplified Chinese
537746-AB1 Keyboard, USB, Taiwan
537746-AC2 Keyboard, USB, Hong Kong
537746-B31 Keyboard, USB, International English
537746-BB1 Keyboard, USB, Israel
537746-BL1 Keyboard, USB, BHCSY
537746-CA1 Keyboard, USB, Estonia
537746-DD1 Keyboard, USB, Iceland
537746-DE1 Keyboard, USB, Arab

Spare parts
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Spare part Description

number

537745-DF1 Keyboard, USB, Kazakstan

537746-KD1 Keyboard, USB, South Korea

537746-L31 Keyboard, USB, International

537748-001 Mouse, PS2, optical, black

537749-001 Mouse, USB, optical, black

570580-001 Mouse, USB

570838-001 Bezel blank, 5.25-inch

573954-001 Intel Core2 Duo E7600 processor, 3-MB cache, 3.06 GHz
574795-121 Keyboard, washable, French Canada

577495-001 Keyboard, washable, the United States

581058-001 16X DVD-ROM drive

617030-001 6X BD-Writer SuperMulti drive with LightScribe

583006-001 Intel Core2 Duo E7500 processor, 3-MB cache, 2.93 GHz
583653-001 Bezel blank, 3.5-inch

583654-001 Rubber Feet Kit

585157-001 Memory module, 4-GB, PC3 10600, 1333-MHz

585886-001 Intel Celeron E3300 processor, 1-MB cache, 2.50 GHz
587451-001 Chassis stand

593228-001 Intel Core 2 Quad Q9550s processor, 2.83 GHz, 12-MB L2 cache
593229-001 Intel Core 2 Quad Q9505s processor, 2.83 GHz, 6-MB L2 cache (95W)
602071-001 Intel Celeron E3400 processor, 1-MB cache, 2.60 GHz
608748-001 System board (standard) (includes replacement thermal material)
609249-001 USB speakers, external

613663-001 Power supply, 240W, 85% efficiency

613664-001 Power supply, 240W, High Voltage protection

613763-001 Power supply, 240 W

615646-001 16X DVD+RW SuperMulti drive with LightScribe

617840-001 Intel Core2 Duo E6700 processor, 2-MB cache, 3.20 GHz, 1066-MHz FSB
619580-001 Mouse, washable

631411-004 Keyboard, SmartCard, the United States

631411-034 Keyboard, SmartCard, the United Kingdom

631411-044 Keyboard, USB, SmartCard, Germany
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Spare part Description

number

631411-054 Keyboard, USB, SmartCard, France
631411-064 Keyboard, USB, SmartCard, Italy
631411-074 Keyboard, USB, SmartCard, Spain
631411-084 Keyboard, USB, SmartCard, Denmark
631411-094 Keyboard, USB, SmartCard, Norway
631411-104 Keyboard, USB, SmartCard, Sweden
631411-114 Keyboard, USB, SmartCard, Switzerland
631411-124 Keyboard, USB, SmartCard, French Canada
631411-134 Keyboard, USB, SmartCard, Portugal
631411-144 Keyboard, USB, SmartCard, Turkey
631411-154 Keyboard, USB, SmartCard, Greece
631411-164 Keyboard, USB, SmartCard, Latin America
631411-174 Keyboard, USB, SmartCard, Saudi Arabia
631411-184 Keyboard, USB, SmartCard, Belgium
631411-204 Keyboard, USB, SmartCard, Brazil
631411-214 Keyboard, USB, SmartCard, Hungary
631411-224 Keyboard, USB, SmartCard, the Czech Republic
631411-234 Keyboard, USB, SmartCard, Slovakia
631411-244 Keyboard, USB, SmartCard, Poland
631411-254 Keyboard, USB, SmartCard, Russia
631411-264 Keyboard, USB, SmartCard, Bulgaria
631411-274 Keyboard, USB, SmartCard, Romania
631411-284 Keyboard, USB, SmartCard, Thailand
631411-334 Keyboard, USB, SmartCard, the Netherlands
631411-554 Keyboard, USB, SmartCard, Turkey F
631411-AA4 Keyboard, USB, SmartCard, Simplified Chinese
631411-AB4 Keyboard, USB, SmartCard, Taiwan
631411-B44 Keyboard, USB, SmartCard, International English
631411-BB4 Keyboard, USB, SmartCard, Israel
631411-BL4 Keyboard, USB, SmartCard, BHCSY
631411-CA4 Keyboard, USB, SmartCard, Estonia
631411-DD4 Keyboard, USB, SmartCard, Iceland

Spare parts
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Spare part Description

number

631411-DE4 Keyboard, USB, SmartCard, Arab

631411-DF4 Keyboard, USB, SmartCard, Kazakstan

631411-KD4 Keyboard, USB, SmartCard, South Korea

631411-L34 Keyboard, USB, SmartCard, International

631758-001 Intel Core2 Duo E6800 processor, 2-MB cache, 3.33 GHz
632486-001 nVidia Quadro NVS300 PCle x16 graphics card
632827-001 nVidia Quadro NVS300 PCle x1 graphics card
633219-001 Intel Celeron E3500 processor, 1-MB cache, 2.70 GHz
635802-001 Memory module, 1-GB, PC3 10600, 1333-MHz
635803-001 Memory module, 2-GB, PC3 10600, 1333-MHz
636166-001 Card reader, 22-in-1

636919-001 Heat sink (includes replacement thermal material)
636920-001 Front bezel

636921-001 Baffle

636922-001 Chassis fan

636923-001 SATA power cable

636924-001 Access panel

636925-001 Speaker, internal

636926-001 Front /O and power switch assembly

636927-001 250-GB hard drive

636928-001 320-GB hard drive

636929-001 500-GB hard drive

636930-001 1-TB hard drive

637995-001 ATI HD6350, 512-MB PCle x16 graphics card
638813-001 SATA cable, 2 straight ends (19 inch (483 mm))
638814-001 SATA cable, 1 straight end, 1 angled end (25 inch; 635 mm)
638815-001 Serial port

638816-001 Hood sensor

638817-001 Printer port

640126-001 System board — Netclone

646376-001 Intel Core2 Duo E5800 processor, 2-MB cache, 3.20 GHz, 800-MHz FSB
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6 Removal and Replacement Procedures
Small Form Factor (SFF) Chassis

Adherence to the procedures and precautions described in this chapter is essential for proper service.
After completing all necessary removal and replacement procedures, run the Diagnostics utility to
verify that all components operate properly.

Bf NOTE: Not all features listed in this guide are available on all computers.

Serial Number Location

Each computer has a unique serial number and product ID number in the location shown below. Keep
these numbers available for use when contacting customer service for assistance.

Figure 6-1 Serial Number and Product ID Location

Serial Number Location
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Preparation for Disassembly

See Ildentifying the Chassis, Routine Care, and Disassembly Preparation on page 22 for initial safety
procedures.

40

1.

Remove/disengage any security devices that prohibit opening the computer (Installing a Security
Lock on page 88).

Close any open software applications.
Exit the operating system.
Remove any compact disc or media card from the computer.

Turn off the computer and any peripheral devices that are connected to it.

CAUTION: Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the
system is plugged into an active AC outlet. In some systems the cooling fan is on even when the
computer is in the “Standby,” or “Suspend” modes. The power cord should always be
disconnected before servicing a unit.

Disconnect the power cord from the electrical outlet and then from the computer.

Disconnect all peripheral device cables from the computer.

NOTE: During disassembly, label each cable as you remove it, noting its position and routing.
Keep all screws with the units removed.

CAUTION: The screws used in the computer are of different thread sizes and lengths; using
the wrong screw in an application may damage the unit.
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Computer Access Panel

Description Spare part number

Access panel 636924-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 40).

2. Ifthe computer is on a stand, remove the computer from the stand.
3. Loosen the captive thumbscrew (1), then lift the access panel off the computer (2).

Figure 6-2 Removing the Access Panel

To install the access panel, reverse the removal procedure.

Computer Access Panel
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Front Bezel

Description Spare part number

Front bezel 636920-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 40).

2. Remove the access panel (Computer Access Panel on page 41).

3. Lift up the three tabs on the side of the bezel (1), then rotate the bezel off the chassis (2).

Figure 6-3 Removing the Front Bezel

To install the front bezel, reverse the removal procedure.
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Bezel Blanks

Description Spare part number
3.5-inch bezel blank 583653-001
5.25-inch bezel blank 570838-001

On some models, there are bezel blanks covering the 3.5-inch and 5.25-inch external drive bays that
need to be removed before installing a drive. To remove a bezel blank:

1.

2,

4.

Remove the access panel (Computer Access Panel on page 41).

Remove the front bezel (Front Bezel on page 42)..

To remove a bezel blank, push the two retaining tabs that hold the bezel blank in place towards
the outer right edge of the bezel (1) and slide the bezel blank back and to the right to remove it

(2).

Figure 6-4 Removing a Bezel Blank

Replace the front bezel.

Bezel Blanks
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System Board Connections

Refer to the following illustration and table to identify the system board connectors.

44

Figure 6-5 System Board Connections

Table 6-1 System Board Connections

No. System Board Connector System Board Label Color Component

1 DIMM (Channel A) XMM1 black Memory Module

2 DIMM (Channel B) XMM3 white Memory Module

3 Media Card Reader MEDIA black Media Card Reader
4 Power SATA PWR black SATA Drives

5 SATA SATAO dark blue Hard Drive

6 SATA SATA1 white Optical Drive

7 PCI Express x1 X1PCIEXP1 black Expansion Card

8 PCI Express x16 X16PCIEXP2 black Expansion Card

9 PCI (2) PCI1 and PCI2 white Expansion Card
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Installing Additional Memory

Description Spare part number
4-GB, PC3-10600 585157-001
2-GB, PC3-10600 635803-001
1-GB, PC3-10600 635802-001

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3-
SDRAM) dual inline memory modules (DIMMs).

DIMMs

The memory sockets on the system board can be populated with up to two industry-standard DIMMs.
These memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum
memory support, you can populate the system board with up to 8 GB of memory configured in a high-
performing dual channel mode.

DDR3-SDRAM DIMMs
For proper system operation, the DDR3-SDRAM DIMMs must be:
e industry-standard 240-pin
e unbuffered non-ECC PC3-8500 DDR3-1066 MHz-compliant
e 1.5volt DDR3-SDRAM DIMMs
The DDR3-SDRAM DIMMs must also:
e support CAS latency 7 DDR3 1066 MHz (7-7-7 timing)
e contain the mandatory JEDEC SPD information
In addition, the computer supports:
e 512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies
e single-sided and double-sided DIMMs

° DIMMSs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not
supported

Bf NOTE: The system will not operate properly if you install unsupported DIMMs.
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Populating DIMM Sockets

There are two DIMM sockets on the system board: XMM1 (black) and XMM3 (white) with one socket
per channel. XMM1 operates in memory channel A. XMM3 operates in memory channel B. A memory
module must occupy the black XMM1 socket.

Bf NOTE: For systems configured with more than 3 GB of memory and a 32-bit operating system, all
memory may not be available due to system resource requirements. Addressing memory above 4 GB
requires a 64-bit operating system.

Total Memory Socket
Channel A (black) Channel B (white)
1 GB (single channel mode) 1GB
2 GB (dual channel mode) 1GB 1GB
4 GB (dual channel mode) 2GB 2GB
8 GB (dual channel mode) 4GB 4GB

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the DIMMs are installed.

e The system will operate in single channel mode if the DIMM sockets are populated in one
channel only.

e The system will operate in a higher-performing dual channel mode if the total memory capacity
of the DIMM in Channel A is equal to the total memory capacity of the DIMM in Channel B.

e The system will operate in flex mode if the total memory capacity of the DIMM in Channel A is
not equal to the total memory capacity of the DIMM in Channel B. In flex mode, the channel
populated with the least amount of memory describes the total amount of memory assigned to
dual channel and the remainder is assigned to single channel. If one channel will have more
memory than the other, the larger amount should be assigned to Channel A.

e In any mode, the maximum operational speed is determined by the slowest DIMM in the system.
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Installing DIMMs

/A CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power
to drain before adding or removing memory modules. Regardless of the power-on state, voltage is
always supplied to the memory modules as long as the computer is plugged into an active AC outlet.
Adding or removing memory modules while voltage is present may cause irreparable damage to the
memory modules or system board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1.  Prepare the computer for disassembly (Preparation for Disassembly on page 40).

2. Remove the access panel (Computer Access Panel on page 41).

3. Rotate up the drive bay housing to access the memory module sockets on the system board.

Figure 6-6 Rotating the Drive Cage Up

Installing Additional Memory
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4. Open both latches of the memory module socket (1), and insert the memory module into the
socket (2).

Figure 6-7 Installing a DIMM

Vo
o

B NOTE: A memory module can be installed in only one way. Match the notch on the module
with the tab on the memory socket.

A DIMM must occupy the black XMM1 socket.

For maximum performance, populate the sockets so that the memory capacity is equal between
Channel A and Channel B. Refer to Populating DIMM Sockets on page 46 for more information.

5. Push the module down into the socket, ensuring that the module is fully inserted and properly
seated. Make sure the latches are in the closed position (3).

6. Rotate the drive cage back down to its normal position.

Down

—— -

Figure 6-8 Rotating the Drive Cage

7. Replace the access panel.

8. If the computer was on a stand, replace the stand.
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9. Reconnect the power cord and turn on the computer.
10. Lock any security devices that were disengaged when the access panel was removed.

The computer should automatically recognize the additional memory the next time you turn on the
computer.

Removing or Installing an Expansion Card

Description Spare part number
ATI HD6350, 512-MB PCle x16 graphics card 637995-001
nVidia Quadro NVS300 PCle x1 graphics card 632827-001
nVidia Quadro NVS300 PCle x16 graphics card 632486-001
Printer port 638817-001
Serial port, full height 638815-001

The computer has two PCIl expansion slots, one PCI Express x1 expansion slot, and one PCI
Express x16 expansion slot.

Bf NOTE: The PCl and PCl Express slots support only low profile cards.

NOTE: You can install a PCl Express x1, x4, x8, or x16 expansion card in the PCI Express x16 slot.

To install an expansion card:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 40).

2. Remove the access panel (Computer Access Panel on page 41).

3. Locate the correct vacant expansion socket on the system board and the corresponding
expansion slot on the back of the computer chassis.
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4. Release the slot cover retention latch that secures the slot covers by lifting the green tab on the
latch and rotating the latch to the open position.

Figure 6-9 Opening the Expansion Slot Retainer

5. Before installing an expansion card, remove the expansion slot cover or the existing expansion
card.

a. Ifyou are installing an expansion card in a vacant socket, remove the appropriate

expansion slot cover on the back of the chassis. Pull the slot cover straight up then away
from the inside of the chassis.

Figure 6-10 Removing an Expansion Slot Cover
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If you are removing a standard PCI card or PCI Express x1 card, hold the card at each end,
and carefully rock it back and forth until the connectors pull free from the socket. Pull the
expansion card straight up from the socket (1) then away from the inside of the chassis to
release it from the chassis frame (2). Be sure not to scrape the card against the other
components.

NOTE: Before removing an installed expansion card, disconnect any cables that may be
attached to the expansion card.

Figure 6-11 Removing a PCI Express x1 Expansion Card
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c. If you are removing a PCI Express x16 card, pull the retention arm on the back of the
expansion socket away from the card and carefully rock the card back and forth until the
connectors pull free from the socket. Pull the expansion card straight up from the socket
then away from the inside of the chassis to release it from the chassis frame. Be sure not to
scrape the card against the other components.

Figure 6-12 Removing a PCIl Express x16 Expansion Card

6. Store the removed card in anti-static packaging.

7. If you are not installing a new expansion card, install an expansion slot cover to close the open
slot.

/A CAUTION: After removing an expansion card, you must replace it with a new card or
expansion slot cover for proper cooling of internal components during operation.
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To install a new expansion card, hold the card just above the expansion socket on the system
board then move the card toward the rear of the chassis (1) so that the bracket on the card is
aligned with the open slot on the rear of the chassis. Press the card straight down into the

expansion socket on the system board (2).

Figure 6-13 Installing an Expansion Card
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Ef NOTE: When installing an expansion card, press firmly on the card so that the whole
connector seats properly in the expansion card slot.

Rotate the slot cover retention latch back in place to secure the expansion card.

Figure 6-14 Closing the Expansion Slot Retainer

10. Connect external cables to the installed card, if needed. Connect internal cables to the system
board, if needed.

11. Replace the access panel.

Removing or Installing an Expansion Card
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12.
13.
14.

15.

If the computer was on a stand, replace the stand.
Reconnect the power cord and turn on the computer.
Lock any security devices that were disengaged when the access panel was removed.

Reconfigure the computer, if necessary.

Cable Management

The Small Form Factor chassis is a very compact computer and proper routing of the internal cables
is critical to the operation of the computer. Follow good cable management practices when working
inside the computer.

Keep cables away from major heat sources like the heat sink.

Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

Keep cables clear of movable or rotating parts like the power supply and drive cage to prevent
them from being cut or crimped when the component is lowered into its normal position.

When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the
wires.

Some flat ribbon cables come prefolded. Never change the folds on these cables.
Do not bend any cable sharply. A sharp bend can break the internal wires.

Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

Never crease a SATA data cable.

Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.

When removing the power supply power cables from the connector on the system board, always
follow these steps:

1.

2,

Squeeze on the top of the retaining latch attached to the cable end of the connector (1).

Grasp the cable end of the connector and pull it straight up (2).
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/A CAUTION: Always pull the connector - NEVER pull on the cable. Pulling on the cable could
damage the cable and result in a failed power supply.

Figure 6-15 6-pin power connector

Cable Connections

System board connectors are color-coded to make it easier to find the proper connection.

System Board Connector Connector Color Description

P1 White Power supply, 6-pin
PWRCPU White Power supply, 4-pin
SATA PWR1 Black ODD power connector
SATA PWR2 Black HDD power connector
CHFAN Brown Chassis fan

PB/LED Black Front power button/LED
FRONT USBH1 Yellow Front I/O USB

FRONT USB2 Green Front I/O USB

FRONT AUD Blue Front audio

SPKR White Internal speaker

CcOMB Black Serial port

HLOCK Black Hood lock solenoid
HSENSE White Hood sensor

MEDIA Black Media card reader

PAR Black Flying parallel port header

Cable Management



Drives

Description Spare part number

Optical drives:

6X BD-Writer SuperMulti drive with LightScribe 617030-001
16X DVD+RW SuperMulti drive with LightScribe 615646-001
16X DVD-ROM drive 581058-001
Hard drives:

1 TB hard drive 636930-001
500 GB hard drive 636929-001
320 GB hard drive 636928-001
250 GB hard drive 636927-001

Drive cables:

SATA cable, 2 straight ends (19 inch, 483 mm)) 638813-001
SATA cable, 1 straight end, 1 angled end (25-inch (635 mm)) 638814-001
SATA power cable 636923-001

A Torx T-15 screwdriver is needed to remove and install the guide screws on a drive.

/A CAUTION: Make sure personal files on the hard drive are backed up to an external storage device
before removing the hard drive. Failure to do so will result in data loss. After replacing the primary
hard drive, you will need to run the Restore Plus! CD to load the HP factory-installed files.
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Drive Positions

Figure 6-16 Drive Positions

Table 6-2 Drive Positions

1

3.5-inch internal hard drive bay

2

3.5-inch internal drive bay for optional drives (media card reader shown)

3

5.25-inch internal drive bay for optional drives (optical drive shown)

NOTE: The drive configuration on your computer may be different than the drive
configuration shown above.

To verify the type, size, and capacity of the storage devices installed in the computer, run Computer
Setup.

Installing and Removing Drives

When installing additional drives, follow these guidelines:

B NOTE: Referto System Board Connections on page 44 for an illustration of the system board drive
connectors.

The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA
connector on the system board labeled SATAO.

Connect a SATA optical drive to the white SATA connector on the system board labeled SATA1.

Connect a media card reader USB cable to the USB connector on the system board labeled
MEDIA.

The power cable for the SATA drives is a three-headed cable that is plugged into the system
board with the first connector routed to the rear of the hard drive, the second connector routed to
the rear of the 3.5” drive, and the third connector routed to the rear of the 5.25” optical drive.

The system does not support Parallel ATA (PATA) optical drives or PATA hard drives.

You must install mounting screws to ensure the drive will line up correctly in the drive cage and
lock in place. HP has provided extra mounting screws for the internal drive bays (five 6-32
standard screws and four M3 metric screws), installed in the front of the chassis, under the front
bezel. The 6-32 standard screws are required for a secondary hard drive (not supported). All
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other drives (except the primary hard drive) use M3 metric screws. The HP-supplied metric
screws are black and the HP-supplied standard screws are silver.

B NOTE: If you are replacing the primary hard drive, you must remove the four silver and blue
6-32 isolation mounting screws from the old hard drive and install them in the new hard drive.

NOTE: The computer supports one hard drive and one optical drive. If you want to use two
hard drives, you must disconnect the optical drive from the SATA connector and plug the 2nd
hard drive into that SATA connector.

Figure 6-17 Extra Mounting Screw Locations

No. Mounting Screw Device
1 Black M3 Metric Screws All Drives (except hard drives)
2 Silver 6-32 Standard Screws Secondary Hard Drive (in systems supporting two hard drives)

There are at total of five extra silver 6-32 standard screws. Four are used as mounting screws for a secondary hard
drive (not supported). The fifth is used for bezel security (see Front Bezel Security on page 90 for more
information).

/A CAUTION: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the
computer, and unplug the power cord. Do not remove a drive while the computer is on or in standby
mode.

Before handling a drive, ensure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Handle a drive carefully; do not drop it.
Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields
such as monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and
label the package “Fragile: Handle With Care.”
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Removing an Internal 5.25-inch Drive

/A CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.

To remove a 5.25-inch internal drive:

1.
2,

Prepare the computer for disassembly (Preparation for Disassembly on page 40).

Remove the access panel (Computer Access Panel on page 41).

Rotate the drive cage to its upright position (1) and remove the mounting screw on the back left
side of the drive (2).

Figure 6-18 Removing the Drive Mounting Screw

Press and hold down the latch to disconnect the power cable (1) and data cable (2) from the rear
of the optical drive.

Figure 6-19 Disconnecting the Power and Data Cables
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5. Rotate the drive cage back down to its normal position.

/A CAUTION: Be careful not to pinch any cables or wires when rotating the drive cage down.

Figure 6-20 Rotating the Drive Cage Down

oy

6. Slide the drive back until it stops, then lift it up and out of the drive cage.

Figure 6-21 Removing the 5.25-inch Drive

B NOTE: When replacing a drive, transfer the four mounting screws from the old drive to the new one.
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Installing an Optical Drive into the 5.25-inch Drive Bay

To install an optional 5.25-inch optical drive:

1.

2,

Prepare the computer for disassembly (Preparation for Disassembly on page 40).

Remove the access panel (Computer Access Panel on page 41).

If you are installing a drive in a bay covered by a bezel blank, remove the front bezel then
remove the bezel blank. See Bezel Blanks on page 43 for more information.

Install three M3 metric mounting screws in the lower holes on each side of the drive: two on the
right side and one on the front left side. HP has provided extra M3 metric mounting screws on
the front of the chassis, under the front bezel. The M3 metric mounting screws are black. Refer
to Installing and Removing Drives on page 57 for an illustration of the extra M3 metric mounting
screws location.

CAUTION: Use only 5-mm long screws as mounting screws. Longer screws can damage the
internal components of the drive.

NOTE: When replacing the drive, transfer the three M3 metric mounting screws from the old
drive to the new one.

Figure 6-22 Installing Mounting Screws in the Optical Drive
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5. Position the mounting screws on the drive into the J-slots in the drive bay. Then slide the drive
toward the front of the computer until it stops.

Figure 6-23 Installing the Optical Drive

6. Rotate the drive cage to its upright position (1) and install an M3 mounting screw in the back left
side of the drive (2) to secure the drive to the drive cage.

Figure 6-24 Securing the Drive in the Drive Cage

7. Connect the SATA data cable to the white system board connector labeled SATA1 if it is not
already connected.

8. Route the data cable through the cable guides.

/A CAUTION: There are two cable guides that keep the data cable from being pinched by the
drive cage when raising or lowering it. One is located on the bottom side of the drive cage. The
other is located on the chassis frame under the drive cage. Ensure that the data cable is routed
through these guides before connecting it to the optical drive.
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9. Connect the power cable (1) and data cable (2) to the rear of the optical drive.

B NOTE: The power cable for the optical drive is a three-headed cable that is routed from the
system board to the hard drive, then to the rear of the optical drive.

Figure 6-25 Connecting the Power and Data Cables

10. Rotate the drive cage back down to its normal position.

/A CAUTION: Be careful not to pinch any cables or wires when rotating the drive cage down.

Figure 6-26 Rotating the Drive Cage Down
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11. Replace the access panel.

12. If the computer was on a stand, replace the stand.

13. Reconnect the power cord and turn on the computer.

14. Lock any security devices that were disengaged when the access panel was removed.

The system automatically recognizes the drive and reconfigures the computer.

Removing an Internal 3.5-inch Drive

/A CAUTION: All removable media should be taken out of a drive before removing the drive from the
computer.
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The 3.5-inch drive is located underneath the 5.25-inch drive. You must remove the internal 5.25-inch
drive before removing the internal 3.5-inch drive.

1. Follow the procedure in Removing an Internal 5.25-inch Drive on page 59 to remove the 5.25-
inch drive and access the 3.5-inch drive.

/A CAUTION: Ensure that the computer is turned off and that the power cord is disconnected
from the electrical outlet before proceeding.

2. If you are removing a media card reader, disconnect the USB cable from the system board.

Figure 6-27 Disconnecting the Media Card Reader USB Cable

3. Rotate the drive cage to its upright position (1) and remove the mounting screw on the back left
side of the drive (2).

Figure 6-28 Removing the Drive Mounting Screw
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4. Rotate the drive cage back down to its normal position.

Figure 6-29 Rotating the Drive Cage Down

5. Slide the drive back until it stops, then lift it up and out of the drive cage.

Figure 6-30 Removing a 3.5-inch Drive (Media Card Reader Shown)

Bf NOTE: When replacing a 3.5-inch drive, transfer the four mounting screws from the old drive to the
new one.

Installing a Drive into the 3.5-inch Internal Drive Bay
The 3.5-inch bay is located underneath the 5.25-inch drive. To install a drive into the 3.5-inch bay:

1. Follow the procedure in Removing an Internal 5.25-inch Drive on page 59 to remove the 5.25-
inch drive and access the 3.5-inch drive bay.

/A CAUTION: Ensure that the computer is turned off and that the power cord is disconnected
from the electrical outlet before proceeding.

2. Ifyou are installing a drive in a bay covered by a bezel blank, remove the front bezel then
remove the bezel blank. See Bezel Blanks on page 43 for more information.
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3. Install three M3 metric mounting screws in the lower holes on each side of the drive: two on the
right side and one on the front left side. HP has provided extra M3 metric mounting screws on
the front of the chassis, under the front bezel. The M3 metric mounting screws are black. Refer
to Installing and Removing Drives on page 57 for an illustration of the extra M3 metric mounting
screws location.

/A CAUTION: Use only 5-mm long screws as mounting screws. Longer screws can damage the
internal components of the drive.

Bf NOTE: When replacing the drive, transfer the three M3 metric mounting screws from the old
drive to the new one.

Figure 6-31 Installing Mounting Screws in the Media Card Reader

4. Position the mounting screws on the drive into the J-slots in the drive bay. Then slide the drive
toward the front of the computer until it stops.

Figure 6-32 Installing a Drive into the 3.5-inch Drive Bay (Media Card Reader Shown)
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5.

6.

Rotate the drive cage to its upright position (1) and install an M3 mounting screw in the back left
side of the drive (2) to secure the drive to the drive cage.

Figure 6-33 Securing the Drive in the Drive Cage

Rotate the drive cage back down to its normal position.

/A CAUTION: Be careful not to pinch any cables or wires when rotating the drive cage down.

10.
1.
12

Figure 6-34 Rotating the Drive Cage Down

If installing a media card reader, connect the USB cable from the media card reader to the USB
connector on the system board labeled MEDIA.

NOTE: Referto System Board Connections on page 44 for an illustration of the system board
drive connectors.

Replace the 5.25-inch drive.

Replace the access panel.

If the computer was on a stand, replace the stand.
Reconnect the power cord and turn on the computer.

Lock any security devices that were disengaged when the access panel was removed.

The system automatically recognizes the drive and reconfigures the computer.
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Removing and Replacing the Primary 3.5-inch Internal SATA Hard Drive

Bf NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive.

The preinstalled 3.5-inch hard drive is located under the power supply. To remove and replace the
hard drive:

1. Prepare the computer for disassembly (Preparation for Disassembly on page 40).

2. Remove the access panel (Computer Access Panel on page 41).

3. Rotate the drive cage for internal drives to its upright position.

Figure 6-35 Rotating the Drive Cage Up

4. Rotate the power supply to its upright position. The hard drive is located beneath the power
supply.

Figure 6-36 Raising the Power Supply
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5. Press and hold down the latch to disconnect the power cable (1) and data cable (2) from the
back of the hard drive.

Figure 6-37 Disconnecting the Hard Drive Power Cable and Data Cable

6. Press down on the green release latch next to the hard drive (1). While holding the latch down,
slide the drive forward until it stops, then lift the drive up and out of the bay (2).

Figure 6-38 Removing the Hard Drive
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7. Toinstall a hard drive, you must transfer the silver and blue isolation mounting screws from the
old hard drive to the new hard drive.

Figure 6-39 Installing Hard Drive Mounting Screws

8.  Align the mounting screws with the slots on the chassis drive cage, press the hard drive down
into the bay, then slide it back until it stops and locks in place.

Figure 6-40 Installing the Hard Drive

9. Connect the power and data cables to the back of the hard drive.

Bf NOTE: When replacing the primary hard drive, be sure to route the SATA and power cables
through the cable guide on the bottom of the chassis frame behind the hard drive.

The data cable must be connected to the dark blue connector labeled SATAO on the system
board to avoid any hard drive performance problems.

10. Rotate the drive cage for internal drives and the power supply down to their normal positions.
11. Replace the access panel.

12. If the computer was on a stand, replace the stand.

13. Reconnect the power cord and turn on the computer.

14. Lock any security devices that were disengaged when the access panel was removed.
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Baffle

Description Spare part number

Baffle 636921-001

The baffle sits between the front fan and the heat sink.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 40).

2. Remove the access panel (Computer Access Panel on page 41).

3. Remove the cables from the holder on the side of the baffle.

4. Lift the baffle straight up out of the chassis.

Figure 6-41 Removing the baffle

To install the baffle, reverse the removal procedure.
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Front Fan Assembly

Description Spare part number

Front fan assembly 636922-001

The front fan assembily is attached to the front of the chassis.

1.

2.

Prepare the computer for disassembly (Preparation for Disassembly on page 40).

Remove the access panel (Computer Access Panel on page 41).

Remove the front bezel (Front Bezel on page 42).

Remove the baffle (Baffle on page 71).

Disconnect the fan cable from the red/brown system board connector labeled CHFAN1.

Press the two tabs (left, bottom) that secure the fan assembly to the chassis front.

Figure 6-42 Front fan tab locations

Pull the assembly toward the rear of the unit, and then lift it out of the chassis.

Figure 6-43 Removing the front fan

To install the front fan, reverse the removal procedure. Be sure to orient the air flow into the unit.

Chapter 6 Removal and Replacement Procedures Small Form Factor (SFF) Chassis



Hood Sensor

Description Spare part number

Hood sensor 638816-001

The hood sensor is attached in a slot in the rear of the chassis.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 40).

2. Remove the access panel (Computer Access Panel on page 41).

o

Unplug the sensor cable from the white system board connected labeled HSENSE.

4. Slide the hood sensor straight out of the notch in the chassis.

B NOTE: A flat blade screwdriver can be used to push the hood sensor out of the slot.

Figure 6-44 Removing the hood sensor from the chassis fan

To install the hood sensor, reverse the removal procedure.
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Front I/O, Power Switch Assembly

Description Spare part number

Front I/0O and power switch assembly 636926-001

The front I/0 and power switch/LEDs are one assembly, attached to the front of the chassis. Push the
assembly into the chassis to remove.

1.
2.

Prepare the computer for disassembly (Preparation for Disassembly on page 40).

Remove the access panel (Computer Access Panel on page 41).

Remove the front bezel (Front Bezel on page 42).

Remove the chassis fan (Front Fan Assembly on page 72).

Rotate the drive cage to its upright position.

Disconnect the four cables from the system board as follows:

Yellow connector labeled FRNT USB1
Green connector labeled FRNT USB2
Blue connector labeled FRNT AUD

Black connector labeled PB/LED

Remove the screw that secures the assembly to the front of the chassis.

Figure 6-45 Removing the front I/0, power switch/LED assembly screw
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8.

Route the cables through the slots beneath the drive cage, pull the assembly (right side first) into
the chassis, and then remove the assembly from the computer.

Figure 6-46 Routing the cables and removing the power switch assembly

To install the front I/0O and power switch assembly, reverse the removal procedure.

Bf NOTE: Be sure to correctly route the cables beneath the drive cage when reinstalling the assembly.
Proper cable routing prevents damage to the cables and allows the drive cage to close properly.

Speaker

Description Spare part number

Speaker 636925-001

The speaker is attached to the front of the chassis under the rotating drive cage.

1.

2,

Prepare the computer for disassembly (Preparation for Disassembly on page 40).

Remove the access panel (Computer Access Panel on page 41).

Remove the front bezel (Front Bezel on page 42).

Rotate the drive cage to its upright position.
Disconnect the speaker wire from the white system board labeled SPKR

Remove the two screws that secure the speaker to the chassis (1).

Speaker
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7.

Lift the speaker from the inside of the chassis to remove it (2).

Figure 6-47 Removing the speaker

To install the speaker, reverse the removal procedures.

Heat sink
Description Spare part number
Heat sink 636919-001

The heat sink is secured atop the processor with four captive Torx screws. The heat sink does not

include a fan.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 40).
2. Remove the access panel (Computer Access Panel on page 41).

3. Remove the baffle (Baffle on page 71).

4. Remove the chassis fan (Front Fan Assembly on page 72).

5. Loosen the four captive screws that secure the heat sink to the system board tray.

CAUTION: Heat sink retaining screws should be removed in diagonally opposite pairs (as in
an X) to even the downward forces on the processor. This is especially important as the pins on
the socket are very fragile and any damage to them may require replacing the system board.
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6. Lift the heat sink from atop the processor and set it on its side to keep from contaminating the
work area with thermal grease.

Figure 6-48 Removing the heat sink
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When reinstalling the heat sink, make sure that its bottom has been cleaned with an alcohol wipe and
fresh thermal grease has been applied to the top of the processor.

/A CAUTION: Heat sink retaining screws should be tightened in diagonally opposite pairs (as in an X)

to evenly seat the heat sink on the processor to avoid damage that could require replacing the system
board.

Failure to install the baffle may cause the computer to overheat.
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Processor

Description Spare part number

Intel Celeron Processors

E3500, 1-MB cache, 2.70 GHz 633219-001
E3400, 1-MB cache, 2.60 GHz 602071-001
E3300, 1-MB cache, 2.50 GHz 585886-001

Intel Core 2 Quad Processors

Q9550s, 2.83 GHz, 12-MB L2 cache 593228-001

Q9505s, 2.83 GHz, 6-MB L2 cache (95W) 593229-001

Intel Core2 Duo Processors

E8600, 6-MB cache, 3.33 GHz 497732-001
E8500, 6-MB cache, 3.16 GHz 466170-001
E8400, 6-MB cache, 3.00 GHz 509554-001
E7600, 3-MB cache, 3.06 GHz 573954-001

Intel Pentium Processors

E6800, 2-MB cache, 3.33 GHz 631758-001
E6700, 2-MB cache, 3.06 GHz, 1066-MHz FSB 617840-001
E5800, 2-MB cache, 3.20 GHz, 800-MHz FSB 646376-001

1. Prepare the computer for disassembly (Preparation for Disassembly on page 40).

2. Remove the access panel (Computer Access Panel on page 41).

3. Remove the baffle (Baffle on page 71).

4. Remove the heat sink (Heat sink on page 76).

5. Rotate the locking lever to its full open position (1).

6. Raise and rotate the microprocessor retainer to its fully open position (2).
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7. Carefully lift the processor from the socket (3).

/A CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

The heat sink must be installed within 24 hours of installing the processor to prevent damage to
the processor’s solder connections.

Figure 6-49 Removing the processor

To install a new processor:
1. Place the processor in its socket and close the retainer.

2. Secure the locking lever. If reusing the existing heat sink, go to step 3. If using a new heat sink,
go to step 6.

3. Ifreusing the existing heat sink, clean the bottom of the heat sink with the alcohol pad provided
in the spares Kkit.

/A CAUTION: Before reinstalling the heat sink you must clean the top of the processor and the
bottom of the heat sink with an alcohol pad supplied in the spares kit. After the alcohol has
evaporated, apply thermal grease to the top of the processor from the syringe supplied in the
spares kit.

4. Apply the thermal grease provided in the spares kit to the top of the processor and install the
heat sink atop the processor.

5. Gotostep?7.
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6. If using a new heat sink, remove the protective covering from the bottom of the heat sink and
place it in position atop the processor.

7. Secure the heat sink to the system board and system board tray with the four captive screws
and attach the heat sink control cable to the system board.

/A CAUTION: heat sink retaining screws should be tightened in diagonally opposite pairs (as in
an X) to evenly seat the heat sink on the processor. This is especially important as the pins on
the socket are very fragile and any damage to them may require replacing the system board.

Bf NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can
be found on the Web at: http://h18000.www1.hp.com/support/files.

Power Supply

Description Spare part number
Power supply, 240W, 85% efficiency 613663-001
Power supply, 240W, High voltage protection 613664-001
Power supply, 240W 613763-001

/A WARNING! To reduce potential safety issues, only the power supply provided with the computer, a
replacement power supply provided by HP, or a power supply purchased as an accessory from HP
should be used with the computer.

The rotating power supply is located at the rear of the chassis. It is held in place by a bracket — no
screws are used.

/A WARNING! Voltage is always present on the system board when the computer is plugged into an
active AC outlet. To avoid possible personal injury and damage to the equipment the power cord
should be disconnected from the computer and/or the AC outlet before opening the computer.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 40).

2. Remove the access panel (Computer Access Panel on page 41).

3. Rotate the drive cage up and disconnect the power cables from all of the drives.
4. Disconnect the power cables from the system board and drives.
5. Rotate the power supply to its full upright position.

6. Release the power supply cables from the cable retaining clip under the drive cage.
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7.

Pull the power supply forward (1) until the posts (2) on the power supply move forward in the
power supply bracket, and then lift the power supply straight up and out of the chassis.

Figure 6-50 Removing the power supply
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Use the following table to determine the correct power supply/system board connections.

Table 6-3 Power supply cable — system board connector

Power supply connector label System board connector
P1 PWR (P1)

P2 P2

P3 PWRCPU

To install the power supply, reverse the removal procedure.

/A CAUTION: When installing the power supply cables, make sure they are properly positioned so
they are not cut by the drive cage and are not pinched by the rotating power supply.

Power Supply
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System Board
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Description Spare part number
System board — standard (includes thermal material) 608748-001
System board — Netclone (includes thermal material) 640126-001
1. Prepare the computer for disassembly (Preparation for Disassembly on page 40).
2. Remove the access panel (Computer Access Panel on page 41).
3. When replacing the system board, make sure the following components are removed from the
defective system board and installed on the replacement system board:
e  Memory modules (seelnstalling Additional Memory on page 45)
e  Expansion cards (Removing or Installing an Expansion Card on page 49)
e Heat sink (Heat sink on page 76)
e  Processor (Processor on page 78)
4. Remove the baffle from the chassis (Baffle on page 71).
5. Remove the fan from the chassis (Front Fan Assembly on page 72).
6. Rotate the drive cage to its upright position.
7. Rotate the power supply to its full upright position.
8. Disconnect all data and power cables from the system board.
9. Disconnect the balance of the cables from the system board.
10. Remove the eight screws (1) that secure the system board to the chassis.

Chapter 6 Removal and Replacement Procedures Small Form Factor (SFF) Chassis



11. Slide the system board toward the front of the chassis (2), and then lift the rear of the system
board up and out of the chassis (3).

To install the system board, reverse the removal procedure.

Bf NOTE: When replacing the system board, you must also change the chassis serial number in the
BIOS.

/\ CAUTION: Before reinstalling the heat sink you must clean the top of the processor and the bottom
of the heat sink with an alcohol pad supplied in the spares kit. After the alcohol has evaporated, apply
thermal grease to the top of the processor from the syringe supplied in the spares kit.

CAUTION: When reconnecting the cables it is important that they be positioned so they do not
interfere with the rotation of the drive cage or power supply.
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Battery

The battery that comes with your computer provides power to the real-time clock and has a lifetime of
about three years. When replacing the battery, use a battery equivalent to the battery originally
installed on the computer. The computer comes with a 3-volt lithium coin cell battery.

L)

NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC
wall socket. The lithium battery is only used when the computer is NOT connected to AC power.

/A WARNING! This computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 140°F (60°C).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.
Replace the battery only with the HP spare designated for this product.

/A CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings.
When the battery is removed or replaced, the CMOS settings will be cleared. Refer to Computer
Setup (F10) Utility on page 4 for information on backing up the CMOS settings.

Bf NOTE: HP encourages customers to recycle used electronic hardware, HP original print cartridges,
and rechargeable batteries. For more information about recycling programs, go to http://www.hp.com/

recycle.

/A CAUTION: Static electricity can damage the electronic components of the computer or optional
equipment. Before beginning these procedures, ensure that you are discharged of static electricity by
briefly touching a grounded metal object.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 40).

2. Remove the access panel (Computer Access Panel on page 41).

Bf NOTE: It may be necessary to remove an expansion card to gain access to the battery.

3. Locate the battery and battery holder on the system board.

4. Depending on the type of battery holder on your system board, complete the following
instructions to replace the battery:
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Type 1 Battery Holder

1.

Lift the battery out of its holder.

Figure 6-52 Removing the battery from a type 1 holder

Slide the replacement battery into position, positive side up.

The battery holder automatically secures the battery in the proper position.
Replace the computer access panel.

Plug in the computer and turn on power to the computer.

Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to Computer Setup (F10) Utility on page 4.

Type 2 Battery Holder

1.

To release the battery from its holder, squeeze the metal clamp that extends above one edge of
the battery. When the battery pops up, lift it out (1).

To insert the new battery, slide one edge of the replacement battery under the holder’s lip with
the positive side up (2). Push the other edge down until the clamp snaps over the other edge of
the battery.

Figure 6-53 Removing the battery from a type 2 holder

Battery
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3. Replace the computer access panel.
4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to Computer Setup (F10) Utility on page 4.

Type 3 Battery Holder
1. Pull back on the clip (1) that holds the battery in place, then remove the battery (2).
2. Insert the new battery and position the clip back in place.

Figure 6-54 Removing the battery from a type 3 holder

3. Replace the computer access panel.
4. Plug in the computer and turn on power to the computer.

5. Reset the date and time, your passwords, and any special system setups, using Computer
Setup. Refer to Computer Setup (F10) Utility on page 4.
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Using the Small Form Factor Computer in a Tower
Orientation

The Small Form Factor computer can be used in a tower orientation. The HP logo plate on the front
bezel is adjustable for either desktop or tower orientation.

1. Prepare the computer for disassembly (Preparation for Disassembly on page 40).

2. Orient the computer so that its right side is facing down and place the computer in the optional
stand.

Figure 6-55 Changing from Desktop to Tower Orientation
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B NOTE: To stabilize the computer in a tower orientation, HP recommends the use of the
optional tower stand.

3. Lock any security devices that were disengaged when the access panel was removed.

B NOTE: Ensure atleast 10.2 centimeters (4 inches) of space on all sides of the computer remains
clear and free of obstructions.

Using the Small Form Factor Computer in a Tower Orientation
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Installing a Security Lock

The security locks displayed below and on the following pages can be used to secure the computer.

HP/Kensington MicroSaver Security Cable Lock

Figure 6-56 Installing a Cable Lock
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Padlock

Figure 6-57 Installing a Padlock
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Front Bezel Security

The front bezel can be locked in place by installing a security screw provided by HP. To install the
security screw:

1.  Remove/disengage any security devices that prohibit opening the computer.
2. Remove all removable media, such as compact discs or USB flash drives, from the computer.
3. Turn off the computer properly through the operating system, then turn off any external devices.

4. Disconnect the power cord from the power outlet and disconnect any external devices.

/A CAUTION: Regardless of the power-on state, voltage is always present on the system board
as long as the system is plugged into an active AC outlet. You must disconnect the power cord
to avoid damage to the internal components of the computer.

5. If the computer is on a stand, remove the computer from the stand.
6. Remove the access panel and front bezel.

7. Remove one of the five silver 6-32 standard screws located on the front of the chassis behind
the bezel.

Figure 6-58 Retrieving the Front Bezel Security Screw

8. Replace the front bezel.
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9. Install the security screw next to the middle front bezel release tab to secure the front bezel in
place.

Figure 6-59 Installing the Front Bezel Security Screw

10. Replace the access panel.
11. If the computer was on a stand, replace the stand.
12. Reconnect the power cord and turn on the computer.

13. Lock any security devices that were disengaged when the access panel was removed.
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A Connector Pin Assignments

This appendix contains the pin assignments for many computer and workstation connectors. Some
of these connectors may not be used on the product being serviced.

Keyboard

Connector and Icon Pin Signal
1 Data
2 Unused
a8 ooooooo 3 Ground
A= G8 ooooooa
B oc—ao 4 +5VDC
5 Clock
6 Unused
Mouse
Connector and Icon Pin Signal
1 Data
2 Unused
éﬂ m A E 3 Ground
oo 4 +5VDC
5 Clock
6 Unused
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Ethernet RJ-45

Connector and Icon Pin Signal
1 (+) Transmit Data
2 (-) Transmit Data
3 (+) Receive Data
G @ @ 4 Unused
‘ﬁ‘ 5 Unused
6 (-) Receive Data
7 Unused
8 Unused

Serial Interface, Powered and Non-Powered

USB

Connector and Icon Pin Signal
1 Carrier Detect (12V if powered)
2 Receive Data
3 Transmit Data
4 Data Terminal Ready
Il O Il O Il 5 Signal Ground
6 Data Set Ready
7 Request to Send
8 Clear to Send
9 Ring Indicator (5V if powered)
Connector and Icon Pin Signal
1 +5VDC
il 3 + Data
4 Ground

Ethernet RJ-45

93



Microphone

Connector and Icon (1/8” miniphone) Pin Signal
1 (Tip) Audio_left
123
&lﬁ.ﬂﬂ:[]: QOU 2 (Ring) Power_Right
3 (Shield) Audio_right
Headphone
Connector and Icon (1/8” miniphone) Pin Signal
1 (Tip) Audio_left
123
qﬁﬁfﬂ:[]: “ )) 2 (Ring) Power_Right
3 (Shield) Ground
Line-in Audio
Connector and Icon (1/8” miniphone) Pin Signal
1 (Tip) Audio_In_Left
123
qﬁ.ﬁﬂﬂ:[]: “ 2 (Ring) Audio_In_Right
3 (Shield) Ground
Line-out Audio
Connector and Icon (1/8” miniphone) Pin Signal
1 (Tip) Audio_Out_Left
123
qﬁ.ﬁﬂﬂ:[]: = 2 (Ring) Audio_Out_Right
3 (Shield) Ground
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Monitor

Connector and Icon

Pin Signal Pin Signal
1 Red Analog 9 +5V (fused)
2 Green Analog 10 Ground
3 Blue Analog 11 Not used
4 Not used 12 DDC Serial Data
5 Ground 13 Horizontal Sync
6 Ground 14 Vertical Sync
7 Ground 15 DDC Serial Clock
8 Ground
DVI Connector
Connector and Icon
(R =)
1 =
Pin Signal Pin Signal
1 T.M.D.S. Data2— 13 T.M.D.S. Data3+
2 T.M.D.S. Data2+ 14 +5V Power
3 T.M.D.S. Data2/4 Shield 15 Ground (for +5V)
4 T.M.D.S. Data4— 16 Hot Pug Detect

Monitor
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5 T.M.D.S. Datad+ 17 T.M.D.S. Data0—
6 DDC Clock 18 T.M.D.S. Data0O+
7 DDC Data 19 T.M.D.S. Data0/5 Shield
8 No Connect 20 T.M.D.S. Data5-
9 T.M.D.S. Data1- 21 T.M.D.S. Data5+
10 T.M.D.S. Data1+ 22 T.M.D.S. Data Shield
11 T.M.D.S. Data1/3 Shield 23 T.M.D.S. Clock+
12 T.M.D.S. Data3— 24 T.M.D.S. Clock-
4-Pin Power (for CPU)
Connector and Icon Pin Signal
1 GND
43
O] E@ :O 2 GND
@E 3 +12V CPU
2 1
4 -12V CPU
6-Pin Power (for CPU) (CMT, SFF)
Connector and Icon Pin Signal
1 GND
1 3 2 GND
[=](™)(") 3 GND
O: @EE 4 12V CPU
4 =6
5 12V CPU
6 +12V
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SATA Data and Power

Drive Connector

S1 S7 P1 P15
[yt
Pin Signal Pin Signal Pin Signal Pin Signal
S1 Ground S2 A+ S3 A- S4 Ground
S5 B- S6 B+ S7 Ground
P1 Ground P2 V3.3 P3 V3.3 P4 Ground
P5 B- P6 Ground P7 V5 P8 V5
P9 V5 P10  Ground P11 Reserved P12  Ground
P13 V12 P14 V12 P15 V12

S = Data, P = Power

SATA Data and Power
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PCI Express

x1, x4, x8, and x16 PCI Express Connector

A1 A18
yd
0000000000 000000

AnAOOn0,

/,LI I I | I_I_IA\
B1 B18
Pin A
Pin Signal Pin Signal Pin Signal Pin  Signal Pin Signal
1 PRSNT1 6 JTAG3 11 PERST# 16 PERpO 21  PERp1
2 +12V 7 JTAG4 12 GND 17  PERnO 22  PERn1
3 +12V 8 JTAGS 13  REFCLK+ 18 GND 23 GND
4 GND 9 +3.3V 14  REFCLK- 19 RSVD 24 GND
5 JTAG2 10 +3.3V 15 GND 20 GND 25 PERp2
26 PERn(2) 31  GND 36 PERn4 41  GND 46 GND
27 GND 32 RSVD 37 GND 42 GND 47  PERp7
28 GND 33 RSVD 38 GND 43  PERp6 48 PERn7
29 PERp3 34 GND 39 PERp5 44  PERn6 49 GND
30 PERn3 35 PERp4 40 PERn5 45 GND 50 RSVD
51 GND 56  PERp9 61 PERn10 66 GND 71 GND
52  PERp8 57 PERn9 62 GND 67 GND 72  PERp13
53 PERNS8 58 GND 63 GND 68 PERp12 73  PERn13
54 GND 59 GND 64 PERp11 69 PERn12 74 GND
55 GND 60 PERp10 65 PERn11 70 GND 75 GND
76  PERp14 81 PERn15
77 PERn14 82 GND
78 GND
79 GND
80 PERp15

NOTE: x1 PCI Express uses pins 1-18
x4 PCI Express uses pins 1-32
x8 PCI Express uses pins 1-49

x16 PCI Express uses pins 1-8
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PCI Express

x1, x4, x8, and x16 PCI Express Connector

A1

AB2

B1 B82
PinB
Pin Signal Pin Signal Pin Signal Pin Signal Pin Signal
1 +12V 6 SMDAT 11 WAKE# 16 GND 21 GND
2 +12V 7 GND 12 RSVD 17 GND 22 GND
3 RSVD 8 +3.3V 13  GND 18 GND 23  PETp2
4 GND 9 JTAG1 14  PETpO 19 PETp1 24 PETn2
5 SMCLK 10  3.3vAux 15 PETnO 20 PETn1 25 GND
26 GND 31 PRSNT2# 36 GND 41  PETp6 46  PETn7
27  PETp3 32 GND 37 PETp5 42  PRTn6 47 GND
28 PETn3 33 PETp4 38 PETn5 43 GND 48  PRSNT2#
29 GND 34 PETn4 39 GND 44  GND 49 GND
30 RSVD 35 GND 40 GND 45 PETp7 50 PETp8
51  PETn8 56 GND 61 GND 66 PETp12 71 PETn13
52 GND 57 GND 62 PETp11 67 PETn12 72 GND
53 GND 58 PETp10 63  PETn11 68 GND 73 GND
54  PETp9 59  PETn10 64 GND 69 GND 74  PETp14
55 PETn9 60 GND 65 GND 70 PETp13 75 PETn14
76  GND 81  PRSNT2#
77 GND 82 RSVD
78 PETp15
79 PETn15
80 GND
NOTE: x1 PCI Express uses pins 1-18

x4 PCI Express uses pins 1-32
x8 PCI Express uses pins 1-49

x16 PCI Express uses pins 1-8

PCI Express

99



B Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch
feature on the computer permits it to operate from any line voltage between 100-120 or 220-240 volts
AC. Power supplies on those computers that do not have external power switches are equipped with
internal switches that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where
you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use
the computer.

General Requirements

The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for
evaluation in the country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a
nominal voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3.  The diameter of the wire must be a minimum of 0.75 mm, or 18AWG, and the length of the cord
must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed
upon it or against it. Particular attention should be paid to the plug, electrical outlet, and the point
where the cord exits from the product.

/A WARNING! Do not operate this product with a damaged power cord set. If the power cord set is
damaged in any manner, replace it immediately.

Japanese Power Cord Requirements

For use in Japan, use only the power cord received with this product.

/A CAUTION: Do not use the power cord received with this product on any other products.
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Country-Specific Requirements

Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency Country Accrediting Agency
Australia (1) EANSW Italy (1) IMQ

Austria (1) OVE Japan (3) METI

Belgium (1) CEBC Norway (1) NEMKO

Canada (2) CSA Sweden (1) SEMKO

Denmark (1) DEMKO Switzerland (1) SEV

Finland (1) SETI United Kingdom (1) BSI

France (1) UTE United States (2) UL

Germany (1) VDE

1.

The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm, conductor size. Power cord set fittings (appliance

coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it
will be used.

The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm, conductor size. Wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.

Country-Specific Requirements
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POST Error Messages

This appendix lists the error codes, error messages, and the various indicator light and audible
sequences that you may encounter during Power-On Self-Test (POST) or computer restart, the
probable source of the problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count
and non-error text messages. If a POST error occurs, the screen will display the error message. To
manually switch to the POST Messages Enabled mode during POST, press any key (except F10,
F11, or F12). The default mode is POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.

Quick Boot is a fast startup process that does not run all of the system level tests, such as the
memory test. Full Boot runs all of the ROM-based system tests and takes longer to complete.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish
the schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.

B NOTE: For more information on Computer Setup, see the Computer Setup (F10) Utility Guide.
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POST Numeric Codes and Text Messages

This section covers those POST errors that have numeric codes associated with them. The section
also includes some text messages that may be encountered during POST.

Bf NOTE: The computer will beep once after a POST text message is displayed on the screen.

Table C-1 Numeric Codes and Text Messages

Control panel message

Description

Recommended action

101-Option ROM Checksum Error

System ROM or expansion board option
ROM checksum.

1. Verify the correct ROM.
2. Flash the ROM if needed.

3. If an expansion board was recently
added, remove it to see if the problem
remains.

4. Clear CMOS. (See Password Security
and Resetting CMOS on page 157.)

5. Ifthe message disappears, there may
be a problem with the expansion card.

6. Replace the system board.

103-System Board Failure

DMA or timers.

1. Clear CMOS. (See Password Security
and Resetting CMOS on page 157.)

2.  Remove expansion boards.

3. Replace the system board.

104-ECC Network Controller has been
enabled

Enable network controller

1. For this setting to take effect, remove
power from the system for 15 seconds.

110-Out of Memory Space for Option ROMs

Recently added PCI expansion card
contains an option ROM too large to
download during POST.

1. If a PCl expansion card was recently
added, remove it to see if the problem
remains.

2. In Computer Setup, set Advanced >
Device Options > NIC PXE Option
ROM Download to DISABLE to
prevent PXE option ROM for the
internal NIC from being downloaded
during POST to free more memory for
an expansion card's option ROM.
Internal PXE option ROM is used for
booting from the NIC to a PXE server.

162-System Options Not Set

Configuration incorrect.

RTC (real-time clock) battery may need to

be replaced.

Run Computer Setup and check the
configuration in Advanced > Onboard
Devices.

Reset the date and time under Control
Panel. If the problem persists, replace the
RTC battery. See the Hardware Reference
Guide for instructions on installing a new
battery, or contact an authorized dealer or
reseller for RTC battery replacement.
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Table C-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

163-Time & Date Not Set

Invalid time or date in configuration
memory.

RTC (real-time clock) battery may need to
be replaced.

Reset the date and time under Control
Panel (Computer Setup can also be used).
If the problem persists, replace the RTC
battery. See the Hardware Reference Guide
for instructions on installing a new battery,
or contact an authorized dealer or reseller
for RTC battery replacement.

163-Time & Date Not Set

CMOS jumper may not be properly
installed.

Check for proper placement of the CMOS
jumper if applicable.

164-MemorySize Error

Memory amount has changed since the last
boot (memory added or removed).

Press the F1 key to save the memory
changes.

164-MemorySize Error

Memory configuration incorrect.

1. Run Computer Setup or Windows
utilities.

2. Make sure the memory module(s) are
installed properly.

3. If third-party memory has been added,
test using HP-only memory.

4.  Verify proper memory module type.

201-Memory Error

RAM failure.

1. Ensure memory modules are correctly
installed.

2. Verify proper memory module type.

3. Remove and replace the identified
faulty memory module(s).

4. If the error persists after replacing
memory modules, replace the system
board.

213-Incompatible Memory Module in
Memory Socket(s) X, X, ...

A memory module in memory socket
identified in the error message is missing
critical SPD information, or is incompatible
with the chipset.

1. Verify proper memory module type.
2. Try another memory socket.

3. Replace DIMM with a module
conforming to the SPD standard.

214-DIMM Configuration Warning

Populated DIMM Configuration is not
optimized.

Rearrange the DIMMs so that each channel
has the same amount of memory.

301-Keyboard Error

Keyboard failure.

1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.
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Table C-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

303-Keyboard Controller Error

1/0 board keyboard controller.

1. Reconnect keyboard with computer
turned off.

2. Replace the system board.

304-Keyboard or System Unit Error

Keyboard failure.

1. Reconnect the keyboard with computer
turned off.

2. Ensure that none of the keys are
depressed.

3. Replace the keyboard.

4. Replace the system board.

501-Display Adapter Failure

Graphics display controller.

1. Reseat the graphics card
(if applicable).

2. Clear CMOS. (See Password Security
and Resetting CMOS on page 157.)

3. Verify monitor is attached and turned
on.

4. Replace the graphics card (if possible).

510-Flash Screen Image Corrupted

Flash Screen image has errors.

Reflash the system ROM with the latest
BIOS image.

513-Front Chassis fan not detected

Front chassis fan is not connected or may
have malfunctioned.

1. Reseat front chassis fan.
2. Reseat fan cable.

3. Replace front chassis fan.

515-Power Supply fan not detected

Power supply fan is not connected or may
have malfunctioned.

1. Reseat power supply fan.
2. Reseat fan cable.

3. Replace power supply fan.

660-Display cache is detected unreliable

Integrated graphics controller display cache
is not working properly and will be disabled.

Replace system board if minimal graphics
degrading is an issue.

912-Computer Cover Has Been Removed
Since Last System Startup

Computer cover was removed since last
system startup.

No action required.

917-Front Audio Not Connected

Front audio harness has been detached or
unseated from motherboard.

Reconnect or replace front audio harness.

918-Front USB Not Connected

Front USB harness has been detached or
unseated from motherboard.

Reconnect or replace front USB harness.

921-Device in PCI Express slot failed to
initialize

There is an incompatibility/problem with this
device and the system or PCI Express Link
could not be retrained to an x1.

Try rebooting the system. If the error
reoccurs, the device may not work with this
system

POST Numeric Codes and Text Messages
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Table C-1 Numeric Codes and Text Messages (continued)

Control panel message

Description

Recommended action

1151-Serial Port A Address Conflict
Detected

Both external and internal serial ports are
assigned to COM1.

1. Remove any serial port expansion
cards.

2. Clear CMOS. (See Password Security
and Resetting CMOS on page 157.)

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1152-Serial Port B Address Conflict
Detected

Both external and internal serial ports are
assigned to COM2.

1. Remove any serial port expansion
cards.

2. Clear CMOS. (See Password Security
and Resetting CMOS on page 157.)

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1155-Serial Port Address Conflict Detected

Both external and internal serial ports are
assigned to same IRQ.

1. Remove any serial port expansion
cards.

2. Clear CMOS. (See Password Security
and Resetting CMOS on page 157.)

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1720-SMART Hard Drive Detects Imminent
Failure

Hard drive is about to fail. (Some hard
drives have a hard drive firmware patch that
will fix an erroneous error message.)

1. Determine if hard drive is giving correct
error message. Enter Computer Setup
and run the Drive Protection System
test under Storage > DPS Self-test.

2. Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3. Back up contents and replace hard
drive.

1796-SATA Cabling Error

One or more SATA devices are improperly
attached. For optimal performance, the
SATA 0 and SATA 1 connectors must be
used before SATA 2 and SATA 3.

Ensure SATA connectors are used in
ascending order. For one device, use SATA
0. For two devices, use SATA 0 and SATA
1. For three devices, use SATA 0, SATA 1,
and SATA 2.

1801-Microcode Patch Error

Processor is not supported by ROM BIOS.

1. Upgrade BIOS to proper version.

2. Change the processor.
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Table C-1 Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

2200-PMM Allocation Error during MEBXx Memory error during POST execution of the 1. Reboot the computer.

Download Management Engine (ME) BIOS Extensions
option ROM. 2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.  If the memory configuration was
recently changed, unplug the
computer, restore the original memory
configuration, and reboot the
computer.

4. If the error persists, replace the system

board.
Invalid Electronic Serial Number Electronic serial number is missing. Enter the correct serial number in Computer
Setup.
Network Server Mode Active and No Keyboard failure while Network Server 1. Reconnect keyboard with computer
Keyboard Attached Mode enabled. turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

Parity Check 2 Parity RAM failure. Run Computer Setup and Diagnostic
utilities.
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Interpreting POST Diagnostic Front Panel LEDs and

Audible Codes

This section covers the front panel LED codes as well as the audible codes that may occur before or
during POST that do not necessarily have an error code or text message associated with them.

/A WARNING!

When the computer is plugged into an AC power source, voltage is always applied to

the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to

cool before touching.

B NOTE:

If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of

the computer and refer to the following table to determine the front panel LED codes.

Recommended actions in the following table are listed in the order in which they should be

performed.

Not all diagnostic lights and audible codes are available on all models.

Table C-2 Diagnostic Front Panel LEDs and Audible Codes

Activity Beeps Possible Cause Recommended Action
Green Power LED On. None Computer on. None
Green Power LED flashes None Computer in Suspend to None required. Press any key or move the
every two seconds. RAM mode (some models mouse to wake the computer.
only) or normal Suspend
mode.
Red Power LED flashes two 2 Processor thermal 1. Ensure that the computer air vents are not
times, once every second, protection activated: blocked and the processor cooling fan is
followed by a two second running.
pause. Beeps stop after fifth A fan may be blocked or
iteration but LEDs continue not turning. 2.  Open hood, press power button, and see if
until problem is solved. the processor fan spins. If the processor fan
OR is not spinning, make sure the fan's cable is
) plugged onto the system board header.
The heat sink/fan
assembly is not properly 3, |ffan is plugged in, but is not spinning, then
attached to the processor. replace heat sink/fan assembly.
4. Contact an authorized reseller or service
provider.
Red Power LED flashes three 3 Processor not installed 1. Check to see that the processor is present.

times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue
until problem is solved.

(not an indicator of bad
processor).

2. Reseat the processor.
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Table C-2 Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause

Recommended Action

Red Power LED flashes four 4
times, once every second,
followed by a two second

pause. Beeps stop after fifth OR
iteration but LEDs continue
until problem is solved.

Power failure (power
supply is overloaded).

The incorrect external
power supply adapter is

being used on the USDT.

1. Open the hood and ensure the 4 or 6-wire
power supply cable is seated into the
connector on the system board.

2. Check if a device is causing the problem by
removing ALL attached devices (such as
hard, diskette, or optical drives, and
expansion cards). Power on the system. If
the system enters the POST, then power off
and replace one device at a time and
repeat this procedure until failure occurs.
Replace the device that is causing the
failure. Continue adding devices one at a
time to ensure all devices are functioning

properly.
3. Replace the power supply.
4. Replace the system board.
OR

The USDT power supply adapter must be at
135W and use the Smart ID technology before
the system will power up. Replace the power
supply adapter with the HP-supplied USDT
power supply adapter.

Red Power LED flashes five 5
times, once every second,
followed by a two second

pause. Beeps stop after fifth
iteration but LEDs continue

until problem is solved.

Pre-video memory error.

CAUTION: To avoid damage to the DIMMs or
the system board, you must unplug the computer
power cord before attempting to reseat, install, or
remove a DIMM module.

1. Reseat DIMMs.

2. Replace DIMMs one at a time to isolate the
faulty module.

3. Replace third-party memory with HP
memory.

4. Replace the system board.

Red Power LED flashes six 6
times, once every second,
followed by a two second

pause. Beeps stop after fifth
iteration but LEDs continue

until problem is solved.

Pre-video graphics error.

For systems with a graphics card:
1. Reseat the graphics card.

2. Replace the graphics card.
3. Replace the system board.

For systems with integrated graphics, replace
the system board.
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Table C-2 Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps

Possible Cause

Recommended Action

Red Power LED flashes 7
seven times, once every

second, followed by a two

second pause. Beeps stop

after fifth iteration but LEDs
continue until problem is

solved.

System board failure
(ROM detected failure
prior to video).

Replace the system board.

Red Power LED flashes eight 8
times, once every second,
followed by a two second

pause. Beeps stop after fifth
iteration but LEDs continue

until problem is solved.

Invalid ROM based on
bad checksum.

Reflash the system ROM with the latest
BIOS image. See the “Boot Block
Emergency Recovery Mode” section of the
Desktop Management Guide for more
information.

Replace the system board.

Red Power LED flashes nine 9
times, once every second,
followed by a two second

pause. Beeps stop after fifth
iteration but LEDs continue

until problem is solved.

System powers on but is
unable to boot.

Check that the voltage selector, located on
the rear of the power supply (some
models), is set to the appropriate voltage.
Proper voltage setting depends on your
region.

Unplug the AC power cord from the
computer, wait 30 seconds, then plug the
power cord back in to the computer.

Replace the system board.

Replace the processor.

Red Power LED flashes ten 10
times, once every second,

followed by a two second

pause. Beeps stop after fifth
iteration but LEDs continue

until problem is solved.

Bad option card.

Check each option card by removing the
card (one at a time if multiple cards), then
power on the system to see if fault goes
away.

Once a bad card is identified, remove and
replace the bad option card.

Replace the system board.
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Table C-2 Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause Recommended Action

Red Power LED flashes 11 The current processor 1. Install a TXT capable processor.

eleven times, once every does not support a

second, followed by a two feature previously 2. Disable TXT in the Computer Setup (F10)
second pause. Beeps stop enabled on this system. utility.

after fifth iteration but LEDs

continue until problem is 3. Reinstall the original processor.

solved.

System does not power on None System unable to power Press and hold the power button for less than 4

and LEDs are not flashing. on. seconds. If the hard drive LED turns green, the
power button is working correctly. Try the
following:

1. Check that the voltage selector (some
models), located on the rear of the power
supply, is set to the appropriate voltage.
Proper voltage setting depends on your
region.

2. Replace the system board.
OR

Press and hold the power button for less than 4
seconds. If the hard drive LED does not turn on
green then:

1. Check that the unit is plugged into a
working AC outlet.

2. Open hood and check that the power button
harness is properly connected to the
system board.

3. Check that both power supply cables are
properly connected to the system board.

4. Check to see if the 5V_aux light on the
system board is turned on. If it is turned on,
then replace the power button harness. If
the problem persists, replace the system
board.

5. Ifthe 5V_aux light on the system board is
not turned on, remove the expansion cards
one at a time until the 5V_aux light on the
system board turns on. It the problem
persists, replace the power supply.
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Troubleshooting Without Diagnostics

This chapter provides information on how to identify and correct minor problems, such as diskette
drive, hard drive, optical drive, graphics, audio, memory, and software problems. If you encounter

problems with the computer, refer to the tables in this chapter for probable causes and recommended

solutions.

B NOTE: For information on specific error messages that may appear on the screen during Power-On
Self-Test (POST) at startup, refer to POST Error Messages on page 102.

Safety and Comfort

/A WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment
may result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/
ergo for more information on choosing a workspace and creating a safe and comfortable work
environment. This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. For more information, refer to the Safety & Regulatory
Information guide.

Before You Call for Technical Support

If you are having problems with the computer, try the appropriate solutions below to try to isolate the
exact problem before calling for technical support.

112

Run the HP diagnostic tool.

Run the hard drive self-test in Computer Setup. Refer to the Computer Setup (F10) Utility Guide
for more information.

Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights
are error codes that will help you diagnose the problem. Refer to POST Error Messages
on page 102 for more information.

If the screen is blank, plug the monitor into a different video port on the computer if one is
available. Or, replace the monitor with a monitor that you know is functioning properly.

If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

If you recently added new hardware, remove the hardware and see if the computer functions
properly.
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e If you recently installed new software, uninstall the software and see if the computer functions
properly.

e Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When
booting the operating system, use “Last Known Configuration.”

e Refer to the comprehensive online technical support at http://www.hp.com/support.

e Refer to Helpful Hints on page 113 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with
self-solve diagnostics. If you need to contact HP support, use HP Instant Support Professional
Edition's online chat feature. Access HP Instant Support Professional Edition at: http://www.hp.com/

golispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online
support information, software and drivers, proactive notification, and worldwide community of peers
and HP experts.

If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that
your service call is handled properly:

e Bein front of your computer when you call.

e  Write down the computer serial number, product ID number, and monitor serial number before
calling.

e Spend time troubleshooting the problem with the service technician.
e Remove any hardware that was recently added to your system.
e Remove any software that was recently installed.

e Restore the system from the Recovery Disc Set that you created or restore the system to its
original factory condition in HP Backup and Recovery Manager.

/A CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data
files before running the restore process.

Bf NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized
service provider or dealer.

Helpful Hints

If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:

e  Check that the computer and monitor are plugged into a working electrical outlet.

e Check that the voltage select switch (some models) is set to the appropriate voltage for your
region (115V or 230V).

e  Check that the computer is turned on and the green power light is on.

e  Check that the monitor is turned on and the green monitor light is on.
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Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights
are error codes that will help you diagnose the problem. Refer to POST Error Messages
on page 102 for more information.

Turn up the brightness and contrast controls of the monitor if the monitor is dim.
Press and hold any key. If the system beeps, then the keyboard should be operating correctly.
Check all cable connections for loose connections or incorrect connections.

Wake the computer by pressing any key on the keyboard or pressing the power button. If the
system remains in suspend mode, shut down the computer by pressing and holding the power
button for at least four seconds then press the power button again to restart the computer. If the
system will not shut down, unplug the power cord, wait a few seconds, then plug it in again. The
computer will restart if it is set to power on automatically as soon as power is restored in
Computer Setup. If it does not restart, press the power button to start the computer.

Reconfigure the computer after installing a non-plug and play expansion board or other option.
See Solving Hardware Installation Problems on page 140 for instructions.

Be sure that all the needed device drivers have been installed. For example, if you are using a
printer, you need a driver for that model printer.

Remove all bootable media (diskette, CD, or USB device) from the system before turning it on.

If you have installed an operating system other than the factory-installed operating system,
check to be sure that it is supported on the system.

If the system has multiple video sources (embedded, PCI, or PCI-Express adapters) installed
(embedded video on some models only) and a single monitor, the monitor must be plugged into
the monitor connector on the source selected as the primary VGA adapter. During boot, the
other monitor connectors are disabled and if the monitor is connected into these ports, the
monitor will not function. You can select which source will be the default VGA source in
Computer Setup.

CAUTION: When the computer is plugged into an AC power source, there is always voltage applied
to the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.
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Solving General Problems

You may be able to easily resolve the general problems described in this section. If a problem
persists and you are unable to resolve it yourself or if you feel uncomfortable about performing the
operation, contact an authorized dealer or reseller.

/A WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to
cool before touching.

Computer appears locked up and will not turn off when the power button is pressed.

Cause Solution

Software control of the power switch is not functional. 1. Press and hold the power button for at least four
seconds until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to USB keyboard or mouse.

Cause Solution

Computer is in standby mode. To resume from standby mode, press the power button or
press any key.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

System has locked up. Restart computer.

Computer date and time display is incorrect.

Cause Solution

RTC (real-time clock) battery may need to be replaced. First, reset the date and time under Control Panel
(Computer Setup can also be used to update the RTC date

NOTE: Connecting the computer to a live AC outlet and time). If the problem persists, replace the RTC battery.

prolongs the life of the RTC battery. See the Hardware Reference Guide for instructions on

installing a new battery, or contact an authorized dealer or
reseller for RTC battery replacement.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key may be on. Press the Num Lock key. The Num Lock light should not be
on if you want to use the arrow keys. The Num Lock key can
be disabled (or enabled) in Computer Setup.
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There is no sound or sound volume is too low.

Cause

Solution

System volume may be set low or muted.

1. Check the F10 BIOS settings to make sure the internal
system speaker is not muted (this setting does not
affect the external speakers).

2. Make sure the external speakers are properly
connected and powered on and that the speakers'
volume control is set correctly.

3. Use the system volume control available in the
operating system to make sure the speakers are not
muted or to increase the volume.

Cannot remove computer cover or access panel.

Cause

Solution

Smart Cover Lock, featured on some computers, is locked.

Unlock the Smart Cover Lock using Computer Setup.

The Smart Cover FailSafe Key, a device for manually
disabling the Smart Cover Lock, is available from HP. You
will need the FailSafe Key in case of forgotten password,
power loss, or computer malfunction. Order PN 166527-001
for the wrench-style key or PN 166527-002 for the
screwdriver bit key.

Poor performance is experienced.

Cause

Solution

Processor is hot.

1. Make sure airflow to the computer is not blocked. Leave
a 10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2. Make sure fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Hard drive is full.

Transfer data from the hard drive to create more space on
the hard drive.

Low on memory.

Add more memory.

Hard drive fragmented.

Defragment hard drive.

Program previously accessed did not release reserved
memory back to the system.

Restart the computer.

Virus resident on the hard drive.

Run virus protection program.
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Poor performance is experienced.

Cause

Solution

Too many applications running.

Close unnecessary applications to free up memory.

Add more memory. Some applications run in the
background and can be closed by right-clicking on their
corresponding icons in the task tray. To prevent these
applications from launching at startup, go to Start >
Run (Windows XP), Start > Accessories > Run
(Windows Vista), or click on the Windows 7 start icon in
the bottom left corner of the screen (Windows 7) and
type msconfig. On the Startup tab of the System
Configuration Utility, clear applications that you do not
want to launch automatically.

Some software applications, especially games, are stressful

on the graphics subsystem

2.

3.

Lower the display resolution for the current application
or consult the documentation that came with the
application for suggestions on how to improve
performance by adjusting parameters in the application.

Add more memory.

Upgrade the graphics solution.

Cause unknown.

Restart the computer.

Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a
two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing).

Cause

Solution

Processor thermal protection activated:
A fan may be blocked or not turning.
OR

The heat sink is not properly attached to the processor.

Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

Open hood, press power button, and see if the
processor fan spins. If the processor fan is not spinning,
make sure the fan's cable is plugged onto the system
board header.

If fan is plugged in, but is not spinning, then replace the
heat sink/fan assembly.

Contact an authorized reseller or service provider.
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System does not power on and the LEDs on the front of the computer are not flashing.

Cause

Solution

System unable to power on.

Press and hold the power button for less than 4 seconds. If
the hard drive LED turns green, then:

1.

3.

OR

Check that the voltage selector, located on the rear of
the power supply on some models, is set to the
appropriate voltage. Proper voltage setting depends on
your region.

Remove the expansion cards one at a time until the
5V_aux light on the system board turns on.

Replace the system board.

Press and hold the power button for less than 4 seconds. If
the hard drive LED does not turn on green then:

1.

2.

Check that the unit is plugged into a working AC outlet.

Open hood and check that the power button harness is
properly connected to the system board.

Check that both power supply cables are properly
connected to the system board.

Check to see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power
button harness.

If the 5V_aux light on the system board is off, then
replace the power supply.

Replace the system board.
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Solving Power Problems

Common causes and solutions for power problems are listed in the following table.

Power supply shuts down intermittently.

Cause Solution

Voltage selector switch on rear of computer chassis (some Select the proper AC voltage using the selector switch.
models) not switched to correct line voltage (115V or 230V).

Power supply will not turn on because of internal power Contact an authorized service provider to replace the power
supply fault. supply.

Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a
two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Processor thermal protection activated: 1. Ensure that the computer air vents are not blocked and
the processor cooling fan is running.
A fan may be blocked or not turning.
2. Open hood, press power button, and see if the
OR processor fan spins. If the processor fan is not spinning,
make sure the fan's cable is plugged onto the system

The heat sink is not properly attached to the processor. board header

3. Iffanis plugged in, but is not spinning, then replace the
heat sink/fan assembly.

4. Contact an authorized reseller or service provider.
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Power LED flashes Red four times, once every second, followed by a two second pause, and the computer beeps
four times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Power failure (power supply is overloaded).

1.

4.

5.

Check that the voltage selector, located on the rear of
the power supply (some models), is set to the
appropriate voltage. Proper voltage setting depends on
your region.

Open the hood and ensure the 4- or 6-wire power
supply cable is seated into the connector on the system
board.

Check if a device is causing the problem by removing
ALL attached devices (such as hard, diskette, or optical
drives, and expansion cards). Power on the system. If
the system enters the POST, then power off and
replace one device at a time and repeat this procedure
until failure occurs. Replace the device that is causing
the failure. Continue adding devices one at a time to
ensure all devices are functioning properly.

Replace the power supply.

Replace the system board.

The incorrect external power supply adapter is being used on
the USDT.

The USDT power supply adapter must be at 135W and use
the Smart ID technology before the system will power up.
Replace the power supply adapter with the HP-supplied
USDT power supply adapter.

Appendix D Troubleshooting Without Diagnostics



Solving Diskette Problems

Common causes and solutions for diskette problems are listed in the following table.

Bf NOTE: The computer does not support internal diskette drives. Only USB diskette drives are
supported.

NOTE: You may need to reconfigure the computer when you add or remove hardware, such as an
additional diskette drive. See Solving Hardware Installation Problems on page 140 for instructions.

Diskette drive light stays on.

Cause Solution

Diskette is damaged. In Microsoft Windows XP, right-click Start, click Explore,
and select a drive. Select File > Properties > Tools. Under
Error-checking click Check Now.

In Microsoft Windows Vista and Windows 7, right-click Start,
click Explore, and right-click on a drive. Select

Properties then select the Tools tab. Under Error-checking
click Check Now.

Diskette is incorrectly inserted. Remove diskette and reinsert.

Drive cable is not properly connected. Reconnect drive cable. Ensure that all four pins on the
diskette power cable are connected to the drive.

Drive not found.

Cause Solution
Cable is loose. Reseat diskette drive data and power cable.
Removable drive is not seated properly. Reseat the drive.

Diskette drive cannot write to a diskette.

Cause Solution

Diskette is not formatted. Format the diskette.
1. From Windows Explorer select the disk (A) drive.
2. Right-click the drive letter and select Format.

3. Select the desired options, and click Start to begin
formatting the diskette.

Diskette is write-protected. Use another diskette or remove the write protection.

Writing to the wrong drive. Check the drive letter in the path statement.
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Diskette drive cannot write to a diskette.

Cause

Solution

Not enough space is left on the diskette.

1. Use another diskette.

2. Delete unneeded files from diskette.

Diskette is damaged.

Replace the damaged disk.

Cannot format diskette.

Cause

Solution

Invalid media reported.

When formatting a disk in MS-DOS, you may need to specify
diskette capacity. For example, to format a 1.44-MB diskette,
type the following command at the MS-DOS prompt:

FORMAT A: /F:1440

Disk may be write-protected.

Open the locking device on the diskette.

Legacy diskette writes are disabled in Computer Setup.

Enter Computer Setup and enable Legacy Diskette Write in
Storage > Storage Options.

A problem has occurred with a disk transaction.

Cause

Solution

The directory structure is bad, or there is a problem with a
file.

In Microsoft Windows XP, right-click Start, click Explore,
and select a drive. Select File > Properties > Tools. Under
Error-checking, click Check Now.

In Microsoft Windows Vista and Windows 7, right-click Start,
click Explore, and right-click on a drive. Select

Properties then select the Tools tab. Under Error-checking
click Check Now.

Diskette drive cannot read a diskette.

Cause

Solution

You are using the wrong diskette type for the drive type.

Check the type of drive that you are using and use the
correct diskette type.

You are reading the wrong drive.

Check the drive letter in the path statement.

Diskette is damaged.

Replace the diskette with a new one.
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“Invalid system disk” message is displayed.

Cause

Solution

A diskette that does not contain the system files needed to
start the computer has been inserted in the drive.

When drive activity stops, remove the diskette and press the
Spacebar. The computer should start up.

Diskette error has occurred.

Restart the computer by pressing the power button.

Cannot Boot to Diskette.

Cause

Solution

Diskette is not bootable.

Replace with a bootable diskette.

Diskette boot has been disabled in Computer Setup.

1. Run Computer Setup and enable diskette boot in
Storage > Boot Order.

2.  Run Computer Setup and enable diskette boot in
Storage > Storage Options > Removable Media
Boot.

NOTE: Both steps should be used as the Removable
Media Boot function in Computer Setup overrides the Boot
Order enable command.

Network server mode is enabled in Computer Setup.

Run Computer Setup and disable Network Server Mode in
Security > Password Options.
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Solving Hard Drive Problems
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Hard drive error occurs.

Cause

Solution

Hard disk has bad sectors or has failed.

1. In Microsoft Windows XP, right-click Start, click
Explore, and select a drive. Select File > Properties >
Tools. Under Error-checking, click Check Now.

In Microsoft Windows Vista and Windows 7, right-click
Start, click Explore, and right-click on a drive. Select
Properties then select the Tools tab. Under Error-
checking click Check Now.

2. Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

Disk transaction problem.

Cause

Solution

Either the directory structure is bad or there is a problem with
a file.

In Microsoft Windows XP, right-click Start, click Explore,
and select a drive. Select File > Properties > Tools. Under
Error-checking, click Check Now.

In Microsoft Windows Vista and Windows 7, right-click Start,
click Explore, and right-click on a drive. Select

Properties then select the Tools tab. Under Error-checking
click Check Now.

Drive not found (identified).

Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 140 section. If the system still
does not recognize the new device, check to see if the
device is listed within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is not listed, the
probable cause is a hardware problem.

If this is a newly installed drive, run the Computer Setup
utility and try adding a POST delay under Advanced >
Power-On.

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.
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Nonsystem disk/NTLDR missing message.

Cause

Solution

The system is trying to start from a diskette that is not
bootable.

Remove the diskette from the diskette drive.

The system is trying to start from the hard drive but the hard
drive may have been damaged.

1. Insert a bootable diskette into the diskette drive and
restart the computer.

2. Check the hard drive format using fdisk: If NTFS
formatting, use a third party reader to evaluate the
drive. If FAT32 formatting, the hard drive cannot be
accessed.

System files missing or not properly installed.

1. Insert a bootable diskette into the diskette drive and
restart the computer.

2. Check the hard drive format using Fdisk: If NFTFS
formatting, use a third party reader to evaluate the
drive. If FAT32 formatting, the hard drive cannot be
accessed.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup.

Run the Computer Setup utility and enable the hard drive
entry in the Storage > Boot Order list.

Bootable hard drive is not attached as first in a multi-hard
drive configuration.

If attempting to boot from a hard drive, ensure it is attached
to the system board connector labeled P60 SATA 0.

Bootable hard drive's controller is not listed first in the Boot
Order.

Run the Computer Setup utility and select Storage > Boot
Order and ensure the bootable hard drive's controller is
listed immediately under the Hard Drive entry.

Computer will not boot from hard drive.

Cause

Solution

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Hard Drive's “Emulation Type” is set to “None.”

Run the Computer Setup utility and change the “Emulation
Type” to “Hard Disk” in the device's details under Storage >
Device Configuration.

Hard drive is damaged.

Observe if the front panel Power LED is blinking RED and if
any beeps are heard. See POST Error Messages

on page 102 to determine possible causes for the blinking
red and beep codes.

See the Worldwide Limited Warranty for terms and
conditions.
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Computer seems to be locked up.

Cause

Solution

Program in use has stopped responding to commands.

Attempt the normal Windows “Shut Down” procedure. If this
fails, press the power button for four or more seconds to turn
off the power. To restart the computer, press the power
button again.

The removable hard drive has no power to the hard drive enclosure.

Cause

Solution

The lock on the enclosure is not turned to the “ON” position.

Insert the key and turn the lock clockwise 90 degrees. The
green LED on the front of the enclosure should be on.

Power cable from the computer power supply to the
enclosure frame is not properly connected.

Check the power supply to make sure it is properly
connected to the rear of the enclosure frame.

The removable hard drive is not recognized by the computer.

Cause

Solution

The removable hard drive carrier is not fully seated in the
enclosure frame or the hard drive is not fully seated in the
carrier.

Push the carrier into the enclosure frame so that the
connector on the rear of the frame is properly seated. If this
does not solve the problem, turn off the computer, remove
the carrier, and check to see if the connector on the hard
drive is properly seated in the carrier.

The removable hard drive enclosure is beeping and the green LED is flashing.

Cause

Solution

Fan failure alarm on the removable hard drive enclosure has

been activated.

Shut down the computer and contact HP for a replacement
enclosure.
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Solving Media Card Reader Problems

Media card will not work in a digital camera after formatting it in Microsoft Windows.

Cause

Solution

By default, Windows will format any media card with a
capacity greater than 32MB with the FAT32 format. Most
digital cameras use the FAT (FAT16 & FAT12) format and
can not operate with a FAT32 formatted card.

Either format the media card in the digital camera or select
FAT file system to format the media card in a computer with
Windows.

A write-protected or locked error occurs when attempting to write to the media card.

Cause

Solution

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on
the right of the SD card is not in the locked position. If using
a Memory Stick/PRO card, make sure that the lock tab
located on the bottom of the Memory Stick/PRO card is not
in the locked position.

Can not write to the media card.

Cause

Solution

The media card is a read-only memory (ROM) card.

Check the manufacturer’'s documentation included with your
card to see if it writable. Refer to the previous section for a
list of compatible cards.

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on
the right of the SD card is not in the locked position. If using
a Memory Stick/PRO card, make sure that the lock tab
located on the bottom of the Memory Stick/PRO card is not
in the locked position.

Unable to access data on the media card after inserting it into a slot.

Cause

Solution

The media card is not inserted properly, is inserted in the
wrong slot, or is not supported.

Ensure that the card is inserted properly with the gold
contact on the correct side. The green LED will light if
inserted properly.
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Do not know how to remove a media card correctly.

Cause

Solution

The computer’s software is used to safely eject the card.

Open My Computer (Windows XP), Computer (Windows
Vista), or Devices and Printers (Windows 7), right-click on
the corresponding drive icon, and select Eject. Then pull the
card out of the slot.

NOTE: Never remove the card when the green LED is
flashing

After installing the media card reader and booting to Windows, the reader and the inserted cards are not recognized

by the computer.

Cause

Solution

The operating system needs time to recognize the device if
the reader was just installed into the computer and you are
turning the PC on for the first time.

Wait a few seconds so that the operating system can
recognize the reader and the available ports, and then
recognize whatever media is inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause

Solution

The inserted media card has boot capability.

If you do not want to boot from the media card, remove it
during boot or do not select the option to boot from the
inserted media card during the boot process.
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Solving Display Problems

If you encounter display problems, see the documentation that came with the monitor and to the
common causes and solutions listed in the following table.

Blank screen (no video).

Cause

Solution

Monitor is not turned on and the monitor light is not on.

Turn on the monitor and check that the monitor light is on.

Bad monitor.

Try a different monitor.

The cable connections are not correct.

Check the cable connection from the monitor to the computer
and to the electrical outlet.

You may have a screen blanking utility installed or energy
saver features are enabled.

Press any key or click the mouse button and, if set, type your
password.

System ROM is corrupted; system is running in Boot Block
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image. See
the “Boot Block Emergency Recovery Mode” section of the
Desktop Management Guide for more information

You are using a fixed-sync monitor and it will not sync at the
resolution chosen.

Be sure that the monitor can accept the same horizontal
scan rate as the resolution chosen.

Computer is in standby mode.

Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Monitor cable is plugged into the wrong connector.

If the computer system has both an integrated graphics
connector and an add-in graphics card connector, plug the
monitor cable into the graphics card connector on the back of
the computer.

Monitor settings in the computer are not compatible with the
monitor.

1. In Windows XP Control Panel, double-click the Display
icon and select the Settings tab.

In Windows Vista Control Panel, under Appearance
and Personalization, select Adjust screen
resolution.

In Windows 7, right click in an empty space on the
desktop and select Screen Resolution.

2. Reset the resolution.

Monitor is configured to use an input that is not active.

Use the monitor's on-screen menu controls to select the
input that is being driven by the system. Refer to the
monitor's user documentation for more information on the on-
screen controls and settings.
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Cannot enable integrated graphics after installing a PCI Express graphics card.

Cause

Solution

On systems with Intel integrated graphics, the integrated

graphics cannot be enabled after installing a PCI Express

x16.

The integrated graphics can be enabled in Computer Setup if
a PCl or PCI Express x1 graphics card is installed, but it
cannot be enabled if there is a graphics card in the PCI
Express x16 slot.

Blank screen and the power LED flashes Red five times, once every second, followed by a two second pause, and
the computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Pre-video memory error.

1.  Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

Blank screen and the power LED flashes Red six times, once every second, followed by a two second pause, and
the computer beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Pre-video graphics error.

For systems with a graphics card:

1. Reseat the graphics card. Power on the system.
2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system
board.

Blank screen and the power LED flashes Red seven times, once every second, followed by a two second pause, and
the computer beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

System board failure (ROM detected failure prior to video).

Replace the system board.

Monitor does not function properly when used with energy saver features.

Cause

Solution

Monitor without energy saver capabilities is being used with

energy saver features enabled.

Disable monitor energy saver feature.
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Dim characters.

Cause

Solution

The brightness and contrast controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly connected.

Check that the graphics cable is securely connected to the
graphics card and the monitor.

Blurry video or requested resolution cannot be set.

Cause

Solution

If the graphics controller was upgraded, the correct graphics
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution.

Change requested resolution.

Graphics card is bad.

Replace the graphics card.

The picture is broken up, rolls, jitters, or flashes.

Cause

Solution

The monitor connections may be incomplete or the monitor
may be incorrectly adjusted.

1. Be sure the monitor cable is securely connected to the
computer.

2. In a two-monitor system or if another monitor is in close
proximity, be sure the monitors are not interfering with
each other’s electromagnetic field by moving them
apart.

3. Fluorescent lights or fans may be too close to the
monitor.

Monitor needs to be degaussed.

Degauss the monitor. Refer to the documentation that came
with the monitor for instructions.

Image is not centered.

Cause

Solution

Position may need adjustment.

Press the monitor's Menu button to access the OSD menu.
Select ImageControl/ Horizontal Position or Vertical
Position to adjust the horizontal or vertical position of the
image.
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“No Connection, Check Signal Cable” displays on screen.

Cause

Solution

Monitor video cable is disconnected.

Connect the video cable between the monitor and computer.

CAUTION: Ensure that the computer power is off while
connecting the video cable.

“Out of Range” displays on screen.

Cause

Solution

Video resolution and refresh rate are set higher than what
the monitor supports.

Restart the computer and enter Safe Mode. Change the
settings to a supported setting then restart the computer so
that the new settings take effect.

Vibrating or rattling noise coming from inside a CRT monitor when powered on.

Cause

Solution

Monitor degaussing coil has been activated.

None. It is normal for the degaussing coil to be activated
when the monitor is powered on.

Clicking noise coming from inside a CRT monitor.

Cause

Solution

Electronic relays have been activated inside the monitor.

None. It is normal for some monitors to make a clicking noise
when turned on and off, when going in and out of standby
mode, and when changing resolutions.

High pitched noise coming from inside a flat panel monitor.

Cause

Solution

Brightness and/or contrast settings are too high.

Lower brightness and/or contrast settings.
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Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to
center the picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause

Solution

Flat panel monitor’s internal digital conversion circuits may
be unable to correctly interpret the output synchronization of

the graphics card.

1. Select the monitor’s Auto-Adjustment option in the
monitor’s on-screen display menu.

2. Manually synchronize the Clock and Clock Phase on-
screen display functions. To download a SoftPaq that
will assist you with the synchronization, go to the
following Web site, select the appropriate monitor, and
download either SP32347 or SP32202:
http://www.hp.com/support

Graphics card is not seated properly or is bad.

1. Reseat the graphics card.

2. Replace the graphics card.

Certain typed symbols do not appear correct.

Cause

Solution

The font you are using does not support that particular
symbol.

Use the Character Map to locate and select the appropriate
symbol. Click Start > All Programs > Accessories >
System Tools > Character Map. You can copy the symbol
from the Character Map into a document.
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Solving Audio Problems

If the computer has audio features and you encounter audio problems, see the common causes and

solutions listed in the following table.

Sound cuts in and out.

Cause

Solution

Processor resources are being used by other open
applications.

Shut down all open processor-intensive applications.

Direct sound latency, common in many media player
applications.

In Windows XP only:

1. From the Control Panel, select Sounds and Audio
Devices.

2.  On the Audio tab, select a device from the Sound
Playback list.

3. Click the Advanced button and select the Performance
tab.

4. Set the Hardware acceleration slider to None and the
Sample rate conversion quality slider to Good and
retest the audio.

5. Set the Hardware acceleration slider to Full and the
Sample rate conversion quality slider to Best and
retest the audio.

Sound does not come out of the speaker or headphones.

Cause

Solution

Software volume control is turned down or muted.

Double-click the Speaker icon on the taskbar, then make
sure that Mute is not selected and use the volume slider to
adjust the volume.

Audio is hidden in Computer Setup.

Enable the audio in Computer Setup: Security >
Device Security > System Audio.

The external speakers are not turned on.

Turn on the external speakers.

The audio device may be connected to the wrong jack.

Ensure that the device is connected to the correct jack on the
computer. The speakers should be plugged into the rear line-
out jack and the headphones should be plugged into the
front headphone jack.

External speakers plugged into the wrong audio jack on a
recently installed sound card.

See the sound card documentation for proper speaker
connection.

Digital CD audio is not enabled.

Enable digital CD audio. In the Device Manager, right-click
on the CD/DVD device and select Properties. Make sure
Enable digital CD audio for this CD-ROM device is
checked.

Headphones or devices connected to the line-out connector
mute the internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external speakers.
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Sound does not come out of the speaker or headphones.

Cause

Solution

Computer is in standby mode.

Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Internal speaker is disabled in Computer Setup.

Enable the internal speaker in Computer Setup. Select
Advanced > Device Options > Internal Speaker.

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection, so multiple audio devices may be listed in
Device Manager. Make sure the correct device is being
used.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Sound from headphones is not clear or muffled.

Cause

Solution

Headphones are plugged into the rear audio output
connector. The rear audio output connector is for powered
audio devices and is not designed for headphone use.

Plug the headphones into the headphone connector on the
front of the computer.

Computer appears to be locked up while recording audio.

Cause

Solution

The hard disk may be full.

Before recording, make sure there is enough free space on
the hard disk. You can also try recording the audio file in a
compressed format.

Line-in jack is not functioning properly.

Cause

Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the
jack or set the jack to its default value.
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There is no sound or sound volume is too low.

Cause

Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection, so multiple audio devices may be listed in
Device Manager. Make sure the correct device is being
used.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Solving Printer Problems

If you encounter printer problems, see the documentation that came with the printer and to the
common causes and solutions listed in the following table.

Printer will not print.

Cause

Solution

Printer is not turned on and online.

Turn the printer on and make sure it is online.

The correct printer drivers for the application are not
installed.

1. Install the correct printer driver for the application.
2. Try printing using the MS-DOS command:
DIR C:\ >

[printer port]

where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.

If you are on a network, you may not have made the
connection to the printer.

Make the proper network connections to the printer.

Printer may have failed.

Run printer self-test.

Printer will not turn on.

Cause

Solution

The cables may not be connected properly.

Reconnect all cables and check the power cord and
electrical outlet.

Printer prints garbled information.

Cause

Solution

The correct printer driver for the application is not installed.

Install the correct printer driver for the application.
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Printer prints garbled information.

Cause

Solution

The cables may not be connected properly.

Reconnect all cables.

Printer memory may be overloaded.

Reset the printer by turning it off for one minute, then turn it
back on.

Printer is offline.

Cause

Solution

The printer may be out of paper.
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Solving Keyboard and Mouse Problems

If you encounter keyboard or mouse problems, see the documentation that came with the equipment
and to the common causes and solutions listed in the following table.

Keyboard commands and typing are not recognized by the computer.

Cause Solution

Keyboard connector is not properly connected. 1. On the Windows XP Desktop, click Start > Shut Down.

On the Windows Vista or Windows 7 desktop, click
Start, click the arrow on the lower right corner of the
Start menu, then select Shut Down.

2.  After the shutdown is complete, reconnect the keyboard
to the back of the computer and restart the computer.

Program in use has stopped responding to commands. Shut down your computer using the mouse and then restart
the computer.

Keyboard needs repairs. See the Worldwide Limited Warranty for terms and
conditions.
Computer is in standby mode. Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Cursor will not move using the arrow keys on the keypad.

Cause Solution

The Num Lock key may be on. Press the Num Lock key. The Num Lock light should not be
on if you want to use the arrow keys. The Num Lock key can
be disabled (or enabled) in Computer Setup.

Mouse does not respond to movement or is too slow.

Cause Solution

Mouse connector is not properly plugged into the back of the = Shut down the computer using the keyboard.

computer.
1. Press the Ctrl and Esc keys at the same time (or press

the Windows logo key) to display the Start menu.

2.  Use the arrow keys to select Shut Down and then
press the Enter key.

3.  After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.

138 Appendix D Troubleshooting Without Diagnostics



Mouse does not respond to movement or is too slow.

Cause

Solution

Program in use has stopped responding to commands.

Shut down the computer using the keyboard then restart the
computer.

Mouse may need cleaning.

Remove the roller ball cover on the mouse and clean the
internal components.

Mouse may need repair.

See the Worldwide Limited Warranty for terms and
conditions.

Computer is in standby mode.

Press the power button to resume from standby mode.

CAUTION: When attempting to resume from standby
mode, do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you
will lose any unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause

Solution

Mouse roller ball or the rotating encoder shafts that make
contact with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and
clean the internal components with a mouse cleaning kit
available from most computer stores.
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Solving Hardware Installation Problems

You may need to reconfigure the computer when you add or remove hardware, such as an additional
drive or expansion card. If you install a plug and play device, Windows automatically recognizes the
device and configures the computer. If you install a non—plug and play device, you must reconfigure
the computer after completing installation of the new hardware. In Windows, use the Add Hardware
Wizard and follow the instructions that appear on the screen.

WARNING!

When the computer is plugged into an AC power source, voltage is always applied to

the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to

cool before touching.

A new device is not recognized as part of the system.

Cause

Solution

Device is not seated or connected properly.

Ensure that the device is properly and securely connected
and that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables
are unplugged.

Ensure that all cables are properly and securely connected
and that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on.

Turn off the computer, turn on the external device, then turn
on the computer to integrate the device with the computer
system.

When the system advised you of changes to the
configuration, you did not accept them.

Reboot the computer and follow the instructions for
accepting the changes.

A plug and play board may not automatically configure when

added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic
settings for the board and choose a basic configuration that
does not cause a resource conflict. You can also use
Computer Setup to reconfigure or disable devices to resolve
the resource conflict.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that Device
available is selected for appropriate USB ports under
Security > Device Security.

Computer will not start.

Cause

Solution

Wrong memory modules were used in the upgrade or
memory modules were installed in the wrong location.

1. Review the documentation that came with the system to
determine if you are using the correct memory modules
and to verify the proper installation.

NOTE: DIMM 1 must always be installed.

2. Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for
specific problems.

3. If you still cannot resolve the issue, contact Customer
Support.
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Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps
five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Memory is installed incorrectly or is bad.

CAUTION: To avoid damage to the DIMMs or the system
board, you must unplug the computer power cord before
attempting to reseat, install, or remove a DIMM module.

1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

NOTE: DIMM 1 must always be installed.
3. Replace third-party memory with HP memory.

4. Replace the system board.

Power LED flashes Red six times, once every second, followed by a two second pause, and the computer beeps six
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Graphics card is not seated properly or is bad, or system
board is bad.

For systems with a graphics card:

1. Reseat the graphics card. Power on the system.
2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the system
board.

Power LED flashes Red ten times, once every second, followed by a two second pause, and the computer beeps ten
times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Bad option card.

1. Check each option card by removing the cards one at
time (if multiple cards), then power on the system to see
if fault goes away.

2. Once bad card is identified, remove and replace bad
option card.

3. Replace the system board.
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Solving Network Problems

Some common causes and solutions for network problems are listed in the following table. These
guidelines do not discuss the process of debugging the network cabling.

Wake-on-LAN feature is not functioning.

Cause Solution

S5 Maximum Power Saving feature is enabled. Disable the S5 Maximum Power Saving option in Computer
Setup. Select Power > Hardware Power Management > S5
Maximum Power Saving.

Wake-on-LAN is not enabled. To enable Wake-on-LAN in Windows XP:
1. Select Start > Control Panel.
2. Double-click Network Connections.
3. Double-click Local Area Connection.
4. Click Properties.
5. Click Configure.

6. Click the Power Management tab, then select the
check box to Allow this device to bring the computer
out of standby.

To enable Wake-on-LAN in Windows Vista:
1.  Select Start > Control Panel.

2. Under Network and Internet, select View network
status and tasks.

3. Inthe Tasks list, select Manage network connections.
4. Double-click Local Area Connection.

5. Click the Properties button.

6. Click the Configure button.

7. Click the Power Management tab, then select the
check box to Allow this device to wake the computer.

To enable Wake-on-LAN in Windows 7:
1. Select Start > Control Panel.

2. Under Network and Sharing Center, click Change
adapter settings.

3. Right-click the network connection you want to enable
WOL on and click Properties.

4. Click Configure.
5. Select Allow this device to wake the computer.

6. Click OK.
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Network driver does not detect network controller.

Cause

Solution

Network controller is disabled.

1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system
via Device Manager.

Incorrect network driver.

Check the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer's Web
site.

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause

Solution

No active network is detected.

Check cabling and network equipment for proper connection.

Network controller is not set up properly.

Check for the device status within Windows, such as Device
Manager for driver load and the Network Connections applet
within Windows for link status.

Network controller is disabled.

1. Run Computer Setup and enable network controller.

2. Enable the network controller in the operating system
via Device Manager.

Network driver is not properly loaded.

Reinstall network drivers.

System cannot autosense the network.

Disable auto-sensing capabilities and force the system into
the correct operating mode.

Diagnostics reports a failure.

Cause

Solution

The cable is not securely connected.

Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The cable is attached to the incorrect connector.

Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other
end of the cable.

Ensure that the cable and device at the other end are
operating correctly.

Network controller interrupt is shared with an expansion
board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller is defective.

Contact an authorized service provider.
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Diagnostics passes, but the computer does not communicate with the network.

Cause

Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer.

Select the Network icon in the Control Panel and configure
the network controller.

Network controller stopped working when an expansion board was added to the computer.

Cause

Solution

Network controller interrupt is shared with an expansion
board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller requires drivers.

Verify that the drivers were not accidentally deleted when the
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and
conflicts with the embedded NIC.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

Network controller stops working without apparent cause.

Cause

Solution

The files containing the network drivers are corrupted.

Reinstall the network drivers, using the Recovery Disc Set
created from the hard drive's Recovery Partition.

The cable is not securely connected.

Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The network controller is defective.

Contact an authorized service provider.

New network card will not boot.

Cause

Solution

New network card may be defective or may not meet
industry-standard specifications.

Install a working, industry-standard NIC, or change the boot
sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause

Solution

The network controller is not configured properly.

Verify Network Connectivity, that a DHCP Server is present,
and that the Remote System Installation Server contains the
NIC drivers for your NIC.
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System setup utility reports unprogrammed EEPROM.

Cause Solution

Unprogrammed EEPROM. Contact an authorized service provider.

Solving Memory Problems

If you encounter memory problems, some common causes and solutions are listed in the following
table.

/A CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending
on the Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you
must unplug the computer power cord before attempting to reseat, install, or remove a DIMM module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC
memory. Otherwise, the computer will not boot the operating system.

Bf NOTE: The memory count will be affected by configurations with the Management Engine (ME)
enabled. The ME uses 8MB of system memory in single channel mode or 16MB of memory in dual-
channel mode to download, decompress, and execute the ME firmware for Out-of-Band (OOB), third-
party data storage, and other management functions.

System will not boot or does not function properly after installing additional memory modules.

Cause Solution

A memory module is not installed in the XMM1 (or DIMM1) Ensure that a memory module is installed in the black XMM1
socket. (or DIMM1) socket on the system board. This socket must be
populated with a memory module.

Memory module is not the correct type or speed grade for Replace module with the correct industry-standard device for
the system or the new memory module is not seated the computer. On some models, ECC and non-ECC memory
properly. modules cannot be mixed.

Out of memory error.

Cause Solution
Memory configuration may not be set up correctly. Use the Device Manager to check memory configuration.
You have run out of memory to run the application. Check the application documentation to determine the

memory requirements.

Memory count during POST is wrong.

Cause Solution

The memory modules may not be installed correctly. Check that the memory modules have been installed
correctly and that proper modules are used.

Integrated graphics may use system memory. No action required.
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Insufficient memory error during operation.

Cause Solution

Too many Terminate and Stay Resident programs (TSRs) Delete any TSRs that you do not need.
are installed.

You have run out of memory for the application. Check the memory requirements for the application or add
more memory to the computer.

Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps
five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Memory is installed incorrectly or is bad. 1. Reseat DIMMs. Power on the system.

2. Replace DIMMs one at a time to isolate the faulty
module.

3. Replace third-party memory with HP memory.

4. Replace the system board.

146 Appendix D Troubleshooting Without Diagnostics



Solving Processor Problems

If you encounter processor problems, common causes and solutions are listed in the following table.

Poor performance is experienced.

Cause Solution

Processor is hot. 1.  Make sure the airflow to the computer is not blocked.

2. Make sure the fans are connected and working properly
(some fans only operate when needed).

3. Make sure the processor heat sink is installed properly.

Power LED flashes Red three times, once every second, followed by a two second pause.

Cause Solution

Processor is not seated properly or not installed. 1. Check to see that the processor is present.

2. Reseat the processor.

Power LED flashes Red eleven times, once every second, followed by a two second pause.

Cause Solution

The current processor does not support a feature previously 1. Install a TXT capable processor.

enabled on this system.
2. Disable TXT in the Computer Setup (F10) utility.

3. Reinstall the original processor.
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Solving CD-ROM and DVD Problems

If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the
following table or to the documentation that came with the optional device.

System will not boot from CD-ROM or DVD drive.

Cause

Solution

The device is attached to a SATA port that has been hidden
in the Computer Setup utility.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
CD-ROM is enabled in Storage > Boot Order.

Network Server Mode is enabled in Computer Setup.

Run the Computer Setup utility and disable Network Server
Mode in Security > Password Options.

Non-bootable CD in drive.

Try a bootable CD in the drive.

Boot order not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Drive not found (identified).

Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 140 section. If the system still
does not recognize the new device, check to see if the
device is listed within Computer Setup. If it is listed, the
probable cause is a driver problem. If it is not listed, the
probable cause is a hardware problem.

If this is a newly installed drive, run the Computer Setup
utility and try adding a POST delay under Advanced >
Power-On Options.

The device is attached to a SATA port that has been hidden
in Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

CD-ROM or DVD devices are not detected or driver is not loaded.

Cause

Solution

Drive is not connected properly or not properly configured.

See the documentation that came with the optional device.

Appendix D Troubleshooting Without Diagnostics



Movie will not play in the DVD drive.

Cause

Solution

Movie may be regionalized for a different country.

See the documentation that came with the DVD drive.

Decoder software is not installed.

Install decoder software.

Damaged media.

Replace media.

Movie rating locked out by parental lock.

Use DVD software to remove parental lock.

Media installed upside down.

Reinstall media.

Cannot eject compact disc (tray-load unit).

Cause

Solution

Disc not properly seated in the drive.

Turn off the computer and insert a thin metal rod into the
emergency eject hole and push firmly. Slowly pull the tray
out from the drive until the tray is fully extended, then remove
the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.

Cause

Solution

Media has been inserted upside down.

Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to

determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive
determine the type of media being played. If the disc still
does not start, read the other solutions listed for this topic.

CD or DVD disc is dirty.

Clean CD or DVD with a CD cleaning kit, available from most
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive.

1. Use Device Manager to remove or uninstall the device.

2. Restart the computer and let Windows detect the CD or
DVD driver.

Recording or copying CDs is difficult or impossible.

Cause

Solution

Wrong or poor quality media type.

1. Try using a slower speed when recording.
2. Verify that you are using the correct media for the drive.

3. Try adifferent brand of media. Quality varies widely
between manufacturers.
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USDT computer boots too slow after removing a CD-ROM or DVD drive.

Cause Solution

The system is searching for the drive during boot because
the drive cable is still attached to the system board.

Disconnect the drive cable from the system board.

Solving USB Flash Drive Problems

If you encounter USB flash drive problems, common causes and solutions are listed in the following
table.

USB flash drive is not seen as a drive letter in Windows.

Cause

Solution

The drive letter after the last physical drive is not available.

Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause

Solution

The device is attached to a USB port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure that “Device
available” is selected for “Front USB Ports” and “Rear USB
Ports” under Security > Device Security.

The device was not properly seated before power-up.

Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.

Cause

Solution

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
USB is enabled in Storage > Boot Order.

The image on the device is not bootable.

Follow the procedures described in the “ROM Flash:
Replicating the Setup: Creating a Bootable Device:
Supported USB Flash Media Device” section of the Service
Reference Guide.

The computer boots to DOS after making a bootable flash drive.

Cause

Solution

Flash drive is bootable.

Install the flash drive only after the operating system boots.
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Solving Front Panel Component Problems

If you encounter problems with devices connected to the front panel, refer to the common causes and
solutions listed in the following table.

A USB device, headphone, or microphone is not recognized by the computer.

Cause Solution

Device is not properly connected. 1. Turn off the computer.

2. Reconnect the device to the front of the computer and
restart the computer.

The device does not have power. If the USB device requires AC power, be sure one end is
connected to the device and one end is connected to a live
outlet.

The correct device driver is not installed. 1. Install the correct driver for the device.

2. You might need to reboot the computer.

The cable from the device to the computer does not work. 1. If possible, replace the cable.

2. Restart the computer.

The device is not working. 1. Replace the device.

2. Restart the computer.

USB ports on the computer are disabled in Computer Setup.  Run the Computer Setup utility and ensure that Device
available is selected for appropriate USB ports under
Security > Device Security.

Solving Front Panel Component Problems 151



Solving Internet Access Problems

If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the
common causes and solutions listed in the following table.
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Unable to connect to the Internet.

Cause

Solution

Internet Service Provider (ISP) account is not set up
properly.

Verify Internet settings or contact your ISP for assistance.

Modem is not set up properly.

Reconnect the modem. Verify the connections are correct
using the quick setup documentation.

Web browser is not set up properly.

Verify that the Web browser is installed and set up to work
with your ISP.

Cable/DSL modem is not plugged in.

Plug in cable/DSL modem. You should see a “power” LED
light on the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted
due to bad weather.

Try connecting to the Internet at a later time or contact your
ISP. (If the cable/DSL service is connected, the “cable” LED
light on the front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected.

Connect the CAT5 UTP cable between the cable modem
and the computers’s RJ-45 connector. (If the connection is
good, the “PC” LED light on the front of the cable/DSL
modem will be on.)
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Unable to connect to the Internet.

Cause

Solution

IP address is not configured properly.

Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of
information that a Web server can store temporarily with the
Web browser. This is useful for having the browser

remember some specific information that the Web server can

later retrieve.)

Windows Vista

1. Select Start > Control Panel.
2. Click Network and Internet.
3.  Click Internet Options.

4. In the Browsing history section on the General tab,
click the Delete button.

5. Click the Delete cookies button.
Windows XP
1.  Select Start > Control Panel.

2. Double-click Internet Options.

3.  On the General tab, click the Delete Cookies button.

Windows 7
1.  Select Start > Control Panel.
2. Click Internet Options.

3. Inthe Browsing history section on the General tab,
click the Delete button.

4. Click the Delete cookies button.

Cannot automatically launch Internet programs.

Cause

Solution

You must log on to your ISP before some programs will start.

Log on to your ISP and launch the desired program.

Solving Internet Access Problems
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Internet takes too long to download Web sites.

Cause Solution

Modem is not set up properly. Verify that the modem is connected and communicating
properly.
Windows XP

1. Select Start > Control Panel.
2. Double-click System.
3.  Click the Hardware tab.

4. Inthe Device Manager area, click the Device Manager
button.

5. Double-click Modems.

6. Double-click Agere Systems PCI-SV92PP Soft
Modem.

7. On the General tab, click Diagnostics.

8. Click Query Modem. A “Success” response indicates
the modem is connected and working properly.

Windows Vista

1. Select Start > Control Panel.

2. Click on System and Maintenance.

3. Click on System.

4. Inthe Tasks list, select Device Manager.
5. Double-click Modems.

6. Double-click Agere Systems PCI-SV92PP Soft
Modem.

7. On the General tab, click Diagnostics.

8. Click Query Modem. A “Success” response indicates
the modem is connected and working properly.

Windows 7

1. Select Start > Control Panel.

2. Click on System.

3. Inthe Tasks list, select Device Manager.
4. Double-click Modems.

5. Double-click Agere Systems PCI-SV92PP Soft
Modem.

6. On the General tab, click Diagnostics.

7. Click Query Modem. A “Success” response indicates
the modem is connected and working properly.
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Solving Software Problems

Most software problems occur as a result of the following:

e The application was not installed or configured correctly.

e There is insufficient memory available to run the application.

e There is a conflict between applications.

° Be sure that all the needed device drivers have been installed.

If you have installed an operating system other than the factory-installed operating system,
check to be sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Computer will not continue and no HP logo screen has appeared.

Cause

Solution

POST error has occurred.

Observe the beeps and LED lights on the front of the
computer. See POST Error Messages on page 102 to
determine possible causes.

See the Restore Kit or the Worldwide Limited Warranty for
terms and conditions.

Computer will not continue after HP logo screen has appeared.

Cause

Solution

System files may be damaged.

Use recovery diskette to scan hard drive for errors.

“lllegal Operation has Occurred” error message is displayed.

Cause

Solution

Software being used is not Microsoft-certified for your
version of Windows.

Verify that the software is certified by Microsoft for your
version of Windows (see program packaging for this
information).

Configuration files are corrupt.

If possible, save all data, close all programs, and restart the
computer.

Solving Software Problems
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Contacting Customer Support

For help and service, contact an authorized reseller or dealer. To locate a reseller or dealer near you,
visit http://www.hp.com.

B NOTE: If you take the computer to an authorized reseller, dealer, or service provider for service,
remember to provide the setup and power-on passwords if they are set.

Refer to the number listed in the warranty or in the Support Telephone Numbers guide for technical
assistance.
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Password Security and Resetting
CMOS

This computer supports security password features, which can be established through the Computer
Setup Utilities menu.

This computer supports two security password features that are established through the Computer
Setup Utilities menu: setup password and power-on password. When you establish only a setup
password, any user can access all the information on the computer except Computer Setup. When
you establish only a power-on password, the power-on password is required to access Computer
Setup and any other information on the computer. When you establish both passwords, only the
setup password will give you access to Computer Setup.

When both passwords are set, the setup password can also be used in place of the power-on
password as an override to log in to the computer. This is a useful feature for a network administrator.

If you forget the password for the computer, you can clear that password so you can gain access to
the information on the computer by resetting the password jumper.

CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to
back up the computer CMOS settings before resetting them in case they are needed later. Back up is
easily done through Computer Setup. See the Computer Setup (F10) Utility Guide for information on
backing up the CMOS settings.
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Resetting the Password Jumper

To disable the power-on or setup password features, or to clear the power-on or setup passwords,
complete the following steps:
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1.

Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

With the power cord disconnected, press the power button again to drain the system of any
residual power.

WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

Remove the computer cover or access panel.

Locate the header and jumper.

NOTE: The password jumper is green so that it can be easily identified. For assistance
locating the password jumper and other system board components, see the lllustrated Parts &
Service Map (IPSM) for that particular system. The IPSM can be downloaded from
http://www.hp.com/support.

Remove the jumper from pins 1 and 2. Place the jumper on either pin 1 or 2, but not both, so
that it does not get lost.

Replace the access panel.
Reconnect the external equipment.

Plug in the computer and turn on power. Allow the operating system to start. This clears the
current passwords and disables the password features.

To establish new passwords, repeat steps 1 through 4, replace the password jumper on pins 1
and 2, then repeat steps 6 through 8. Establish the new passwords in Computer Setup.
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Clearing and Resetting the CMOS

The computer’s configuration memory (CMOS) stores information about the computer’s configuration.
The CMOS button resets CMOS but does not clear the power-on and setup passwords.

Clearing CMOS will clear the Active Management Technology (AMT) settings in the Management
Engine BIOS Extension (MEBX), including the password. The password will default to “admin” and will
need to be reset. The AMT settings will also need to be reset. To access the MEBX, press Ctrl+P
during POST.

1. Turn off the computer and any external devices, and disconnect the power cord from the power
outlet.

2. Disconnect the keyboard, monitor, and any other external equipment connected to the computer.

/A WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system
components to cool before touching.

/A CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can
result in damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3.  Remove the computer cover or access panel.

/A CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is
important to back up the computer CMOS settings before resetting them in case they are
needed later. Back up is easily done through Computer Setup.
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4. Locate, press, and hold the CMOS button in for five seconds.

Bf NOTE: Make sure you have disconnected the AC power cord from the wall outlet. The CMOS
button will not clear CMOS if the power cord is connected.

Figure E-1 CMOS button

Bf NOTE: For assistance locating the CMOS button and other system board components, see the
lllustrated Parts & Service Map (IPSM).

5. Replace the computer cover or access panel.
6. Reconnect the external devices.

7. Plug in the computer and turn on power.

Bf NOTE: You will receive POST error messages after clearing CMOS and rebooting advising
you that configuration changes have occurred. Use Computer Setup to reset any special system
setups along with the date and time.
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Drive Protection System (DPS)

The Drive Protection System (DPS) is a diagnostic tool built into the hard drives installed in some
computers. DPS is designed to help diagnose problems that might result in unwarranted hard drive
replacement.

When these systems are built, each installed hard drive is tested using DPS, and a permanent record
of key information is written onto the drive. Each time DPS is run, test results are written to the hard
drive. Your service provider can use this information to help diagnose conditions that caused you to
run the DPS software.

Running DPS will not affect any programs or data stored on the hard drive. The test resides in the
hard drive firmware and can be executed even if the computer will not boot to an operating system.
The time required to execute the test depends on the manufacturer and size of the hard drive; in most
cases, the test will take approximately two minutes per gigabyte.

Use DPS when you suspect a hard drive problem. If the computer reports a SMART Hard Drive
Detect Imminent Failure message, there is no need to run DPS; instead, back up the information on
the hard drive and contact a service provider for a replacement hard drive.
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Accessing DPS Through Computer Setup

When the computer does not power on properly you should use Computer Setup to access the DPS
program. To access DPS, perform the following steps:
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1.
2.

4,

Turn on or restart the computer.

When the F10 Setup message appears in the lower-right corner of the screen, press the F10
key.

NOTE: If you do not press the F10 key while the message is displayed, you must turn the
computer off, then on again, to access the utility.

A choice of five headings appears in the Computer Setup Utilities menu: File, Storage,
Security, Power, and Advanced.

Select Storage > DPS Self-Test.

The screen will display the list of DPS-capable hard drives that are installed on the computer.

NOTE: If no DPS-capable hard drives are installed, the DPS Self-Test option will not appear
on the screen.

Select the hard drive to be tested and follow the screen prompts to complete the testing process.

When the test has been completed, one of three messages will be displayed:

Test Succeeded. Completion Code 0.
Test Aborted. Completion Code 1 or 2.

Test Failed. Drive Replacement Recommended. Completion Code 3 through 14.

If the test failed, the completion code should be recorded and reported to your service provider for
help in diagnosing the computer problem.
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G Computer Diagnostic Features

Hewlett-Packard Vision Diagnostics

Bf NOTE: HP Vision Diagnostics is included on CD with some computer models only.

The Hewlett-Packard Vision Diagnostics utility allows you to view information about the hardware
configuration of the computer and perform hardware diagnostic tests on the subsystems of the
computer. The utility simplifies the process of effectively identifying, diagnosing, and isolating
hardware issues.

The Survey tab is displayed when you invoke HP Vision Diagnostics. This tab shows the current
configuration of the computer. From the Survey tab, there is access to several categories of
information about the computer. Other tabs provide additional information, including diagnostic test
options and test results. The information in each screen of the utility can be saved as an html file and
stored on a USB flash drive.

Use HP Vision Diagnostics to determine if all the devices installed on the computer are recognized by
the system and functioning properly. Running tests is optional but recommended after installing or
connecting a new device.

You should run tests, save the test results, and print them so that you have printed reports available
before placing a call to the Customer Support Center.

Bf NOTE: Third party devices may not be detected by HP Vision Diagnostics.

Accessing HP Vision Diagnostics

To access HP Vision Diagnostics, you must create a Recovery Disc Set then boot to the CD
containing the utility. It can also be downloaded from http://www.hp.com and either burned to CD or
installed to a USB flash drive. See Downloading the Latest Version of HP Vision Diagnostics

on page 167 for more information.

B NOTE: HP Vision Diagnostics is included as part of the Recovery Disk Set with some computer
models only.

If you have already downloaded HP Vision Diagnostics to either CD or USB Flash drive, then begin
the following procedure at step 2.

1. In Windows Explorer, go to C:\SWSetup\ISOs and burn the file Vision Diagnostics.ISO to a
CD or copy it to a USB flash drive.

2.  While the computer is on, insert the CD in the Optical Drive or USB flash drive in a USB port on
the computer.

Hewlett-Packard Vision Diagnostics 163


http://www.hp.com

3.  Shut down the operating system and turn off the computer.

4. Turn on the computer. The system will boot into HP Vision Diagnostics.

Bf NOTE: If the system does not boot to the CD in the optical drive or to the USB flash drive, you
may need to change the boot order in the Computer Setup (F10) utility. Refer to the Computer
Setup (F10) Utility Guide for more information.

5. Atthe boot menu, select either the HP Vision Diagnostics utility to test the various hardware
components in the computer or the HP Memory Test utility to test memory only.

Bf NOTE: The HP Memory Test is a comprehensive memory diagnostic utility that is run as a
stand-alone application, outside of HP Vision Diagnostics.

6. If running HP Vision Diagnostics, select the appropriate language and click Continue.

7. Inthe End User License Agreement page, select Agree if you agree with the terms. The HP
Vision Diagnostics utility launches with the Survey tab displayed.

Survey Tab
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The Survey tab displays important system configuration information.

In the View level field, you can select the Summary view to see limited configuration data or select
the Advanced view to see all the data in the selected category. By default, the View Level is set to
Overview which displays general information about all of the component categories.

In the Category field, you can select the following categories of information to display:
All—Gives a listing of all categories of information about the computer.
Architecture—Provides system BIOS and PCI device information.

Asset Control—Shows product name, system serial number, asset tag and universal unique ID
information.

Audio—Displays information about the audio controllers present in the system, including PCI audio
cards.

Communication—Shows information about the computer parallel (LPT) and serial (COM) port
settings, plus USB and network controller information.

Graphics—Shows information about the graphics controller of the computer.

Input Devices—Shows information about the keyboard, mouse, and other input devices connected
to the computer.

Memory—Shows information about all memory in the computer. This includes memory slots on the
system board and any memory modules installed.

Processors—Shows information about the processor(s) installed in the computer, including clock
speeds and cache sizes.

Storage—Shows information about storage media connected to the computer. This list includes all
hard drives and optical drives.
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System—Shows information about the computer model, internal fans, chassis, and BIOS.

Test Tab

The Test tab allows you to choose various parts of the system to test. You can also choose the type
of test and testing mode.

There are three types of tests to choose from:

e Quick Test—Provides a predetermined script where a sample of each hardware component is
exercised. You may further modify which of the Quick tests are executed by selecting or
deselecting individual tests in the hardware component check list.

e Complete Test—Provides a predetermined script where each hardware component is fully
tested. You may further modify which of the Complete tests are executed by selecting or
deselecting individual tests in the hardware component check list.

e Custom Test—Provides the most flexibility in controlling the testing of a system. The Custom
Test mode allows you to specifically select which devices, tests, and test parameters are run.

By default, the three test modes do not display prompts and require no interaction. If errors are found,
they are displayed when testing is complete.

However, for each test type, you may also optionally add interactive tests by clicking the Include
interactive tests box under Test mode. Selecting interactive tests provides the maximum control
over the testing process. The diagnostic software will prompt you for input during tests.

Bf NOTE: Memory can not be tested from within the HP Vision Diagnostics application. To test the
memory in your computer, you must exit HP Vision Diagnostics, boot to either the CD or USB flash
drive and select HP Memory Test from the boot menu.

To begin testing:

1. Select the Test tab.

2. Select the type of tests you want to run: Quick, Complete, or Custom.
3. Include optional interactive tests by selecting Include interactive tests.

4. Choose how you want the test to be executed, either Number of Loops or Total Test Time.
When choosing to run the test over a specified number of loops, enter the number of loops to
perform. If you want the diagnostic test for a specified time period, enter the amount of time in
minutes.

5. Click the Start Test button to start the testing. The Status tab, which allows you to monitor the
progress of the tests, is automatically displayed during the testing process. When the tests are
complete, the Status tab shows whether the devices passed or failed.

6. If errors are found, go to the Errors tab to display detailed information and recommended
actions.
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Status Tab

The Status tab displays the status of the selected tests. The main progress bar displays the percent
complete of the current set of tests. While testing is in progress, a Cancel Testing button is displayed
for use if you want to cancel the test.

The Status tab also shows:

e The devices being tested

e The test status (running, waiting, passed, or failed) of each device being tested
e The overall test progress of all devices being tested

e The test progress for each device being tested

e The elapsed test times for each device being tested

History Tab

The History tab contains information on past test executions.

The History Log displays all tests that have been executed, the number of times of execution, the
number of times failed, the date each test was executed, and the time it took to complete each test.
The Clear History button will clear the contents of the History Log.

The contents of the History Log may be saved as a HTML file to USB flash drive by clicking the Save
button.

Errors Tab

166

The Errors tab displays detailed information about any errors found, as well as any recommended
actions.

The Error Log displays the tests for devices that have failed during the diagnostic testing and includes
the following columns of information.

e The Device section displays the device tested.
e The Test section displays the type of test run.
e The Times Failed is the number of times the device has failed a test.

e The Defect Code provides a numerical code for the failure. The error codes are defined in the
Help tab.

e The Description section describes the error that the diagnostic test found.
e The Reason section describes the likely cause of the error.

e The Recommended Repair will give a recommended action that should be performed to
resolve the failed hardware.

e The Warranty ID is a unique error code associated with the specific error on your computer.
When contacting the HP Support Center for assistance with a hardware failure, please be
prepared to provide the Warranty ID.
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The Clear Errors button will clear the contents of the Error Log.

The contents of the Error Log may be saved as a HTML file to USB flash drive by clicking the Save
button.

Help Tab

The Help tab contains a Vision Help section, and a Test Components section. This tab includes
search and index features. You may also review the HP End User License Agreement (EULA), as
well as the HP Vision Diagnostic application version information on this tab.

The Vision Help section contains information on the major functions of Hewlett-Packard Vision
Diagnostics.

The Test Components section provides a description of each test, as well as the parameters that
may be adjusted when running in Custom test mode.

The Defect codes section contains information on the numerical error code that may appear in the
Errors tab.

The Memory test tab section provides information on the HP Memory Test application that may be
launched from the boot menu.

The HP Support section provides information on obtaining technical support from HP.

Saving and Printing Information in HP Vision Diagnostics

You can save the information displayed in the HP Vision Diagnostics Survey, History and Errors
tabs to a USB flash drive. You can not save to the hard drive. The system will automatically create an
html file that has the same appearance as the information displayed on the screen.

1. Insert a USB flash drive if running HP Vision Diagnostics from CD.

2. Click Save in the bottom on any of the Survey, History or Errors tabs. All three log files will be
saved regardless of from which tab the Save button was clicked.

3. Select the drive onto which you will save the log files and click the Save button. Three html files
will be saved to the inserted USB flash drive.

149,

B NOTE: Do notremove the USB flash drive until you see a message indicating that the html
files have been written to the media.

4. Print the desired information from the storage device used to save it.

Bf NOTE: To exit HP Vision Diagnostics, click the Exit Diagnostics button at the bottom of the screen.
Be sure to remove the USB flash drive or CD from the optical drive.

Downloading the Latest Version of HP Vision Diagnostics

1. Go to http://www.hp.com.

2. Click the Software & Drivers link.

3. Select Download drivers and software (and firmware).

Hewlett-Packard Vision Diagnostics 167


http://www.hp.com

4. Enter your product name in the text box and press the Enter key.
5. Select your specific computer model.

6. Select your OS.

7. Click the Diagnostic link.

8. Click the Hewlett-Packard Vision Diagnostics link.

9. Click the Download button.

B NOTE: The download includes instructions on how to create the bootable CD or the bootable USB
flash drive.

Protecting the Software

To protect software from loss or damage, you should keep a backup copy of all system software,
applications, and related files stored on the hard drive. See the operating system or backup utility
documentation for instructions on making backup copies of data files.
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H System Recovery

System Recovery completely erases and reformats the hard disk drive, deleting all data files you
have created, and then reinstalls the operating system, programs, and drivers. However, you must
reinstall any software that was not installed on the computer at the factory. This includes software that
came on media included in the computer accessory box, and any software programs you installed
after purchase.

Bf NOTE: Always use the System Restore procedure before you use the System Recovery program.

NOTE: Some features might not be available on systems that are shipped without a version of
Microsoft Windows.

You must choose one of the following methods to perform a System Recovery:

e Recovery Image — Run the System Recovery from a recovery image stored on your hard disk
drive. The recovery image is a file that contains a copy of the original factory-shipped software.
To perform a System Recovery from a recovery image, see System Recovery from the Windows
7 Start Menu on page 170.

EE)

NOTE: The recovery image uses a portion of the hard disk drive that cannot be used for data
storage.

e Recovery Media — Run the System Recovery from recovery media, that you created from files
stored on your hard disk drive, or purchased separately. To create recovery media, see
Recovery media on page 172.
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System Recovery options
You should attempt a System Recovery in the following order:
1. Through the hard disk drive, from the Windows 7 Start menu.
2. Through the hard disk drive, by pressing the F11 key on the keyboard during system startup.
3.  Through recovery media that you create.

4. Through recovery discs purchased from HP Support. To purchase recovery discs, visit
www.hp.com/support.

System Recovery from the Windows 7 Start Menu

/A CAUTION: System Recovery deletes all data and programs you created or installed. Back up any
important data to a removable disc or USB flash drive.

If the computer is working and Windows 7 is responding, use these steps to perform a System
Recovery.

1. Turn off the computer.
2. Disconnect all peripheral devices from the computer except the keyboard and mouse.
3. Turn on the computer.

4. Tap the Start button, tap All Programs, tap Recovery Manager, and then tap Recovery
Manager. If prompted, tap Yes to allow the program to continue.

5. Under I need help immediately, tap System Recovery.

6. Tap Yes, and then tap Next. Your computer restarts.

B NOTE: If your system does not detect a recovery partition, it prompts you to insert recovery
media. Insert the disc, or USB flash drive, tap Yes, and then tap Next to restart the computer
and run Recovery Manager from the recovery disc, or the recovery USB flash drive. If using
discs, insert the next system-recovery disc when prompted.

7. When the computer restarts, you will see the Recovery Manager welcome screen again. Under |
need help immediately, tap System Recovery. If you are prompted to back up your files, and
you have not done so, tap Back up your files first (recommended), and then tap Next.
Otherwise, tap Recover without backing up your files, and then tap Next.

8. System Recovery begins. After System Recovery is complete, tap Finish to restart the
computer.

9. Complete the registration process, and wait until you see the desktop.

10. Turn off the computer, reconnect all peripheral devices, and turn the computer back on.

System Recovery at system startup

/\ CAUTION: System Recovery deletes all data and programs you created or installed. Back up any
important data to a removable disc.
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If Windows 7 is not responding, but the computer is working, follow these steps to perform a System
Recovery.

1. Turn off the computer. If necessary, press and hold the Power button until the computer turns
off.

2. Disconnect all peripheral devices from the computer, except the keyboard and mouse.
3. Press the Power button to turn on the computer.

4. As soon as you see the initial company logo screen appear, repeatedly press the F11 key on
your keyboard until the Windows is Loading Files... message appears on the screen.

5. Under I need help immediately, tap System Recovery.

6. If you are prompted to back up your files, and you have not done so, tap Back up your files
first (recommended), and then tap Next. Otherwise, tap Recover without backing up your
files, and then tap Next.

7. System Recovery begins. After System Recovery is complete, tap Finish to restart the
computer.

8. Complete the registration process, and wait until you see the desktop.

9. Turn off the computer, reconnect all peripheral devices, and turn the computer back on.

System Recovery from recovery media

/A CAUTION: System Recovery deletes all data and programs you created or installed. Back up any
important data to a removable disc, or USB flash drive.

To create recovery media, see Recovery media on page 172.

To perform a System Recovery using recovery media:

1. If the computer is working, create a backup DVD, or backup USB flash drive, containing all the
data files you want to save, and then remove the backup media from the computer.

2. Insert recovery disc #1 into the DVD drive tray, and close the tray; or if using a recovery USB
flash drive, insert it into a USB port.

3.  If the computer works, tap the Start button, and then tap Shut Down. Or, if the computer is not
responding, press and hold the Power button for approximately 5 seconds, or until the computer
turns off.

4. Disconnect all peripheral devices from the computer except the keyboard and mouse.

5. Press the Power button to turn on the computer. If you are using a recovery DVD, the computer
will automatically run Recovery Manager from the disc. Skip to step 7.

6. If you are running System Recovery from a USB flash drive, press the Esc key as the computer
is powering on to bring up the boot menu. Use the arrow keys to select the USB device and
press Enter to boot from that device.

7. If the Recovery Manager asks if you want to run System Recovery from Media or Hard Drive,
select Media. On the Welcome screen, under | need help immediately, tap Factory Reset.
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8. If you are prompted to back up your files, and you have not done so, tap Back up your files
first (recommended), and then tap Next. Otherwise, tap Recover without backing up your
files, and then tap Next.

9. If you are prompted to insert the next recovery disc, do so.

10. When the Recovery Manager is finished, remove all recovery discs, or the recovery USB flash
drive, from the system.

11. Tap Finish to restart the computer.

Recovery media

You should create a set of recovery discs, or a recovery USB flash drive, from the recovery image
stored on your hard disk drive. This image contains the operating system and software program files
that were originally installed on your computer at the factory. You can create only one set of recovery
discs, or one recovery USB flash drive, for your computer; the recovery discs, or the recovery drive,
can be used only with this computer. Store the recovery discs, or the recovery USB flash drive, in a
safe place.

B NOTE: Some features might not be available on systems that are shipped without a version of
Microsoft Windows.

Choosing recovery media

e To create recovery discs, your computer must have a DVD writer, and you must use only high-
quality blank DVD+R or DVD-R discs.

Bf NOTE: You cannot use CDs or DVD+RW, DVD-RW, DVD+RW DL, DVD-RW DL, DVD+R DL,
or DVD-R DL discs to create recovery discs.

e You have the option of creating a recovery USB flash drive instead, using a high-quality blank
USB drive.

e If you are creating recovery discs, be sure to use high-quality discs. It is normal for discs to be
rejected if they are not defect-free. You will be prompted to insert a new blank disc to try again.

e The number of discs in the recovery-disc set depends on your computer model (typically 3—6
DVD discs). The Recovery Media Creation program tells you the specific number of blank discs
needed to make the set. If you are using a USB flash drive, the program will tell you the size of
the drive required to store all the data (minimum of 8 GB).

Bf NOTE: The process of creating recovery discs, or a recovery USB drive, takes some time to
verify that the information written on the disc, or USB flash drive, is correct. You can quit the
process at any time. The next time you run the program, it resumes where it left off.
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Creating recovery media
To create recovery discs:
1. Close all open programs.

2. Tap the Start button, tap All Programs, tap Recovery Manager, and then tap Recovery Media
Creation. If prompted, tap Yes to allow the program to continue.

3. Tap Create recovery media using blank DVD(s), and then tap Next.

4. Follow the on-screen instructions. Label each disc as you make it (for example, Recovery 1,
Recovery 2).

To create a recovery USB flash drive:
1. Close all open programs.
2. Insert the USB flash drive into a USB port on the computer.

3. Tap the Start button, tap All Programs, tap Recovery Manager, and then tap Recovery Media
Creation.

4. Tap Create recovery media with a USB flash drive, and then tap Next.

5. Select the USB flash drive from the list of media. The program will let you know how much
storage is required to create the recovery drive. If the USB flash drive does not have enough
storage capacity (8 GB is the minimum), it will be grayed out on the screen. Tap Next.

Ef NOTE: Recovery Media Creation formats the flash drive and deletes all on files on it.

6. Follow the on-screen instructions. Make sure to label the USB flash drive and store it in a secure
place.

Bf NOTE: Do not use media cards for creating recovery media. The system may not be able to boot up
from a media card and you may not be able to run system recovery.
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| Specifications

Table I-1 Specifications

Desktop Dimensions (in the desktop position)

Height 3.95in 10.0cm
Width 13.3in 33.8cm
Depth 14.9in 37.8cm
Approximate Weight 16.72 1b 7.6 kg
Weight Supported (maximum distributed load in desktop position) 77 b 35 kg

Temperature Range
Operating 50° to 95°F 10° to 35°C

Nonoperating -22° to 140°F -30° to 60°C

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 ft) above sea level; no direct
sustained sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and number of options
installed.

Relative Humidity (noncondensing)

Operating 10-90% 10-90%

Nonoperating (38.7°C max wet bulb) 5-95% 5-95%

Maximum Altitude (unpressurized)

Operating 10,000 ft 3048 m

Nonoperating 30,000 ft 9144 m

Heat Dissipation

Max STD PS 1063 BTU/hr 268 kg-cal/hr
Typical STD PS idle 198 BTU/hr 50 kg-cal/hr
Max EPA 87/89/85% @ 20/50/100% load PS 941 BTU/hr 237 kg-cal/hr
Typical EPA 87/89/85% @ 20/50/100% load PS idle 150 BTU/hr 38 kg-cal/hr
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Table I-1 Specifications (continued)

Power Supply

Power Output

Rated Input Current (maximum)'
Rated Line Frequency

Operating Line Frequency Range
Max Allowable Leakage Current

Power Supply Fan

115V
240W

4A @ 100 VAC
50/60 Hz
47-63 Hz

275 pA

92mm variable speed

230V
240W

2A @ 230 VAC
50/60 Hz
47-63 Hz

275 pA

92mm variable speed

1 This system utilizes an active power factor corrected power supply. This allows the system to pass the CE mark
requirements for use in the countries of the European Union. The active power factor corrected power supply also has the

added benefit of not requiring an input voltage range select switch.
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4-pin power pin assignments 96
6-pin power pin assignments 96

A
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spare part number 31, 41
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108
134

audible codes
audio problems
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chassis fan,
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computer 26

mouse 27

safety precautions 26
CMOS

backingup 157
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computer

specifications 174
computer access panel

removing 41
computer cleaning 26
connecting drive cables 57
connections

SFF system board 55
connector pin assignments 92
country power cord set

requirements 101

Customer Support
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159
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D
diagnostics utility 163
DIMMs. See memory
disassembly preparation 40
diskette problems 121
Drive Protection System

(DPS) 161
drives

connecting cables 57

installing 57
locations 57
removing 57
SFF removal and
replacement 56
DVI pin assignments

E

electrostatic discharge
preventing damage

error

codes 102, 108
messages 103
ethernet

RJ-45 pin assighments 93

expansion card
installing 49
removing 49

expansion slot cover
removing 50
replacing 52

F
fan

spare part number
fan, power supply 28
flash drive problems
flashing LEDs 108
front bezel

removing 42

95

(ESD)
23

31, 38
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removing blanks 43

security 90
spare part
number
front fan

31, 38,42, 43

removal and replacement

front fan assembly
spare part number
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front 1/0 and power switch
assembly
spare part number 38, 74
front I/0, power switch assembly
removal and replacement 74
front panel problems 151

G
general problems 115
grounding methods 24

H
hard drive
installing 68
proper handling 29
removing 68
SATA characteristics 20
spare part number 38, 56
spare part numbers 31, 38
hard drive problems 124
hardware installation
problems 140
headphone pin assignments 94
heat sink
removal and replacement 76
spare part number 31, 38, 76
helpful hints 113
hood sensor
removal and replacement 73
spare part number 38, 73

I

installing
drive cables 57
expansion card 49
hard drive 68
media card reader 65
memory 45
mounting screws 57
optical drive 61

Internet access problems 152

K
keyboard
cleaning 27
pin assignments 92
spare part
numbers 32, 33, 34, 36
keyboard problems 138

L
LEDs
blinking power 0
blinking PS/2 keyboard 108
line-in audio pin assignments 94
line-out audio pin
assignments 94
locks
cable lock 88
front bezel 90
padlock 89

M
media card reader

installing 65

removing 63
Media Card Reader

problems 127

memory

installing 45

populating sockets 46

specifications 45
memory module

spare part number 45
memory modules

spare part number 31, 36, 38
memory problems 145
microphone pin assignments 94
monitor

pin assignments 95
monitor problems 129
mounting screws 57
mouse

cleaning 27

pin assignments 92
mouse problems 138
mouse, spare part number

spare part number 32, 36

N
network problems 142
numeric error codes 103

o
operating guidelines 25
optical drive
installing 61
removing 59
spare part number 36, 56
spare part numbers 31
optical drive problems 148

overheating, prevention 25

P
password
clearing 157
power-on 157
setup 157
PCl card 51
PCI Express card 52
PCI Express pin assighments 98
POST error messages 102
power cord set requirements
country specific 101
power problems 119
power supply
fan 28
removal and replacement 80
spare part number 31, 36, 80
power switch/LED assembly
spare part number 31
power-on password 157
printer problems 136
problems
audio 134
CD-ROMor DVD 148
diskette 121
flash drive 150
front panel 151
general 115
hard drive 124
hardware installation 140
Internet access 152
keyboard 138
Media Card Reader 127
memory 145
monitor 129
mouse 138
network 142
power 119
printer 136
processor 147
software 155
processor
removal and replacement 78
spare part number 32
processor problems 147
product ID location 39
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removal and replacement
baffle 71
battery 84
front fan 72
front 1/0, power switch
assembly 74
heat sink 76
hood sensor 73
power supply 80
processor 78
SFF drives 56
speaker 75
system board 82
removing
bezel blanks 43
computer access panel 41
expansion card 49
expansion slot cover 50
front bezel 42
hard drive 68
media card reader 63
optical drive 59
PCl card 51
PCI Express card 52
resetting
CMOS 157
password jumper 157

S
safety and comfort 112
safety precautions
cleaning 26
SATA
connectors on system
board 20
data cable pinouts 20
hard drive characteristics 20
pin assignments 97
SATA cable
spare part number 31, 38
SATA hard drive cable
spare part number 38
SATA optical drive cable
spare part number 31
screws, correct size 28
security
cable lock 88
front bezel 90
padlock 89
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spare part number
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static electricity 23
system board
removal and replacement 82
SATA connectors 20
spare part number 31, 36, 82
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tamper-proof screws
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temperature control 25
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Torx T15 screwdriver 28
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USB pin assignments 93
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